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Installing

I'm sure you are keen to get started so you'll be pleased to know that the
simple. Simply download the iristailer “rom , run the install file and foll¢
instructions.

The website will detect whether you're on a Mac or PC and offer you the
system. Are you using a PC and do you need Resolume for Mac? No worri
dropdown at the bottom of the page.

Because of the graphical acceleration that is used, Resolume does have
requirements. Please cnhock ifie@r the current minimum requirements.



Registering

The download of Resolume will work in demo mode straight away. You wil

the Resolume logo will appear on the video output and a robotic voice wi
software you are using.

This is the only limitation of the demo. You can use every feature and tr\
has to offer.

In order to get out of demo mode and use Resolume for real, vou can buy
When you have done that, you will receive a serial number.

Entering your Serial

Once you have a serial number, select File > Preferences in Resolume ar
Enter your serial number into the text box and click 'Register’.

Resolume will now use your Internet connection to confirm your serial nu
completed, Resolume will be fully registered. The audio and video reminc



Resolume will occasionally need to check if everything is still in order. |

every time you run Resolume on a computer with a working Internet conn

notice it. If you run Resolume on an offline computer, it will remind you |1

30 days.

Offline Registration

You can register Resolume without having an Internet connection on the

To do this, select File > Preferences in Resolume and click the Registrat
Registration button. Take a note of the ID Code that is shown. You will n
that does have an Internet conneciion tc¢ visit:



You will need to enter your serial number and the ID Code that you just r
website will then generate a registration key file. Transfer this file to thi
installed Resolume on.

Now select File > Preferences in Resolume and click the Registration tab
Registration...' button and then the 'Load registration file..." button. Selc¢
become fully registered.

Unregister

When you need to re-install your operating system or when you have bou
make sure you remove your registration. To remove your Resolume regist
go to the Register tab in the Preferences and click on the "Unregister" b
serial number from the computer.

Sometimes computers get stolen or damaged. Also, we're all humans and
forget things.

In short, stuff happens.

When stuff happens, don't worry. You can still use Resolume. Just iog in
to remove your Resolume license from the lost computer, and you'll be g¢

One License, Many Machines

A multi-seat license will come with a single serial. This serial can be usc¢
registered at the same time. So a Resolume license for 3 computers will
That serial can then be used to keep 3 computers registered simultaneo!



Similarly, when upgrading from Resolume for 1 computers to 2 or more, y
'expanded' to be valid on 2 or more computers. It is not possible to split
serial numbers.

+ 1 Backup

Every Resolume 6 license gets one additional backup.

You can use it to always have a second computer registered and standing
register both your home studio render beast and use the backup for your
keep your second install unused and ready to go when your first compute
you prefer.

The ever important smhlaélnpupmgtrading to a multi-seat license, you still get
you have Resolume for 2 computers, you can install it on 2 computers +

computers + 1 backup. Then 4 computers + 1 backup. Etc etc. You see wl
watched Sesame Street when we were kids, so you know how Count Coun

The backup is there to tie you over in case of emergency. If your shows
need full redundancy, for all your machines, all the time, we kindly ask vy
the required amount of computers.



Basic Vocabulary

Let's get some basic Resolume terminology out of the way. This way we ¢
better when we get into the nitty gritty of how Resolume works. Don't wo!

simple.

Clip

A can consist of a video file or a still image, an audio file, or a combi
also contain a Source, like a live camera input. The clip also has many s

clip is played and how it looks and sounds.

Layer

Each clip sits in a spe@ifily one clip from each layer can play at a time. L
blended together to create the final output.

Group

Layers can be combined irnGxoups are little sub compositions, where mult
composited together and can be controlled with a single fader.

Groups are available on Arena only.

Composition



A is a complete Resolume setup with sets of clips, assigned effe
and control shortcuts. Switching compositions takes some time, so you Il
complete performance as a single composition.

Deck

The clips in a composition are divfdeagdeyoaccess to the clips that you wa
you want them. Switching decks is quick and does not interrupt playback,
between decks while performing.

Effect

can be added to the whole composition, a specific layer, a specific
They change how the output looks or sounds. They're lots of fun and whe
your greatest asset.

Parameter

are used to control everything in Resolume. Everything that can
adjusted with parameters.

A clip has several parameters like playback speed and playback directior
like scale and blend mode, and effects can have loads of different param

You use parameters to fine tune your composition.

Shortcut

MIDI, OSC and keyboardcan be assigned to all the parameters in the inte
don't have to use your mouse to control everything.

See, that wasn't so scary.



Quickstart Tutorial

Right! You've got Resolume installed so let's jump in and see what it can

Run the Resolume application. The Resolume interface will appear. It ma
but don't worry - it will soon all make sense.

A new Resolume install comes with a demo compoisitwdrat Ave call a complq
Resolume setup - each composition can include sets of clips, preprogram
settings that you need for a performance.

Trigger Clips

Below the menu bar, you should see a set of horizontal rows that each hze
left and a set of thumbnails. Each thumobnail is a different

Go ahead and click one of the thumbnails now. The clip will start playing
set up to be synchronised to the BPM (Beats Per Minute) setting, so the
instantly - it will wait for the start of the next bar. Don't worry, if you waea
you can set them up to do that.

But first things first. You should now see the clip playing in the output w
the audio of the clip. Awesome. You're VJ'ing.

You can take control of the clip that is playing by clicking the Clip tab. T
tab is the bit we are interested in for now.

You can use the Forwards, Backwards and Pause icons to start and stop
the moving blue wedge directly to scratch the clip - wikka wikka wah!

Note that messing with the clip like this will mean that it is no longer sy
the tempo will be right but it will be out of phase. You can resynchronise



thumbnail again - it will start again at the start of the next bar.

Mixing
Playing one clip is all very well but mixing clips together is where the fu

Each of the horizontal rows of clips isEaclepayatecan play one clip at a ti
clicking another thumbnail on the same layer as the one that is already p
the start of the next bar, the output will change to play the new clip.

Now try clicking a clip from a different layer. This time, the old clip will
clip will be mixed with it.

Have a look over to the left of the thumbna

are two vertical sliders marked '"A' and 'V'.

these up and down on the layers that you h

playing. Logically enough, the "A' slider fa

of the layer in and out. The 'V' slider does

video. You can also use the 'M' (master) sl
control both at the same time.

Effects

So we've got some clips playing. Let's mess wiin 1ieywwermusimgheomeght hanoc
side of the interface are some tabs that say 'Files', '"Compositions', 'Effe
Effects tab.

Below the tab will now be a list of effects. These are the video effects th
Resolume.



Pick an effect. Any effect will do,

recommend Bendoscope as a good

start with. Now drag it over to the
where there is a tab called Compo:
As you get over there, drop the eff
the area where it says 'Drop effect
here'. You'll know when you're in t
place when you see four colored c«
appear around the Composition tab

You should immediately see that the output video has been distorted by t

Now, look back to the place where you dropped the effect. You will see t
under the Bendoscope effect.

All video effects have the Opacity slider - it is used to mix the effected

Most effects also have
additional parameters the
you can control. Bendosc
has one - the number of
divisions used in its
distortion effect. Try slid
this slider to the left and
right to see what effect it has on the output video. More such trippy.

You can add more effects by dragging them over from the Effects tab. Ea
of the one before it and effects it, so you can combine many effects to m
Or a great big mess.

If you want to get rid of an effect, just click the x to the right of the Effe

Have a Play!

Now is a good time to have a play with Resolume. Play some clips, add s
happens. Most of all, have fun!



A useful feature is the help windov
bottom right of the interface. This
show some brief hints about how tc
whatever the mouse pointer is curr
over.

In the other sections of the manual, we will be looking in detail at all of
if you come across anything that interests you, you will be able to find o



Clips
Clips are the real nuts and bolts of Resolume. Without clips we wouldn't
at the screens and speakers.

A clip is usually a video. But it can be a lot more than that. A clip can al
also be an audio file, or even a combination of audio and video.

Clips can also contaia like a live camera or plugins that generate conten
Basically a clip is any type of media you create your output with.

Triggering Clips

Triggering a clip is as simple as clicking its thumbnail. When you're sick
trigger a new one in its place. Or press the big X to the left of the layer

That's it. That's really all a good VJ does. Trigger the right clip at the ri
reading the manual.

Still here? Cool. Because there are loads of options!

Column Triggering

A column is a vertical set of clips.

You can trigger multiple clips at the same time by triggering the column.
guickly switch looks by triggering a set of clips that work well together.



Trigger Settings

You can change how individual clips respond to a trigger.

TipWant to change a setting before a clip is live? No problem. You can s
by clicking the name handle underneath the thumbnail.

Bonus Tiplll the functions described below can can be changed for multipl
well. Shift select the clips, and then change the function via the Clip me

Beat Snap

You can use the Beat Snap optic
have clips wait until the next be
next bar, in 2 bars, in 4 bars an
before it starts. This is particul;
useful for audio-visual music cli

In some music software, this feature is known as "Quantising".

You can set the Beat Snap option for an individual clip. Select the clip :
Snap menu option.

If you set the clip setting to '"Composition determined’', it will use whatev



is.
You can set the Beat Snap option for the whole Composition through the
menu options.

Clip Target

The default thing that happens \
you click a clip is that it plays «
layer it is held in. You can also
to play in the active layer or ev
use the next available layer.

Like Beat Snap, you can change this setting for the whole Composition (C
and for individual clips (Clip > Clip Target)

The Free Layer Clip Target mode is particularly fun when used with the F
(see below).

You can then play 'chords' of clips with the keyboard or a MIDI device -
displayed for as long as it is selected.

Obviously, you will need as many layers as you want to play simultaneou

Trigger Style



Normally, when you click a clip,
playing and carries on until you
the layer or play another clip.

With the Trigger Style setting, you can also use Piano mode, where the |
when you take your finger off the mouse button, or MIDI key or keyboard
shortcuts.

You can set the Trigger Style for the whole composition through the Com
menu option.

You can set the Trigger Style for an individual clip by selecting it and th
Style menu option.

Auto Pilot

Using the Auto Pilot, you can let Resolume automatically play a different
finishes. Options include the next and previous clip, a random clip, the f
even a specific clip.

You can also turn on the Auto Pilot Handy for that quick bathroom brea
when you need to explain that you're really not the DJ to that one persor
requesting that new banger by DJ Snake.



Fader Start

When Fader Start is enabled for a cl
layer, the clip will re-start from the
every time you fade up the layer it's
in.

This is useful for clips that should start exactly from the time you bring -
intro animations. You can keep them triggered in a layer, ready to go, an
comes, start them by fading them in.

Tipln combination with the "pick-up' playmode (described further below),
into a Fader Stop. The clip will then remain paused where it was the mon
and continue where it was when you fade it back up.

Fader Start can be set per clip (Clip > Fader Start), or the whole layer (I

Ignore Column Trigger

This option allows you to 'lock' a clip or entire layer, so that when you t
particular clip will not get replaced and just keeps playing. The option c:
and Layer menus.

This is particularly useful when using a single clip as a background, or w
Resolume to record a video clip, and you want to keep playing a single a



mixing.

Resize

Here you can quickly set your clips to eith
Fill/Fit/Stretch to the current compositions
back to the original pixel dimensions.

This is not a setting that stays fixed! Rather it's a quick way to make sul
correct size, and you can go into the clip properties and further tweak th

Not sure what Fill, Fit and Stretch do exactly? They're explained below, |
Properties in greater detail.

Thumbnails

Oh yes! You can update the thumbi

clip to the current frame, or even

looks with the clip effects applied.

really picky about your thumbs, yo
even load a still from disk.

Not happy how your thumbnails turned out? You can always revert back t

Persistent Clips

Persistent clips carry over from deck to deck. You can mark one or more
Clip menu. When you then switch to another deck, these persistent clips
slot in every deck you switch to.

This is useful for longer shows, where you always want to have access tc
but not be tied down to a single deck. Promotor logos, flashes or live cal

Did you have an important clip in a deck, which is now covere
Don't worry!

Resolume will let you know there was another clip in the slot by showing
the top left. You can use this thumbnail to free the clip. Just by dragginc

Cut/Copy/Paste/Clear/Rename



If you really don't know what CTRL-c and CTRL-v do,
down with a good friend and asking him or her to sho

Also, props to you because | wouldn't have made it through college witho
people that were smarter than me.

Paste Effects

One option that may stand out is '"Paste Effects'. This will let you copy a
CTRL-c, and then paste just the effects onto one or more other clips usir
feature may be familiar to you from good old Final Cut Pro and it's a rea
same look on a set of clips.

Reveal/Strip Video/Strip Audio

These will show the original clip in Finder or Explor
the audio or video track from a clip.

Careful! Removing the video track when there is no audio track will effec
say | didn't warn you!

Clip Colors

Yes! You can now give each clip or set of clips its own nice pastelly higt

Clip Properties

The clip properties give you important info about the clip. Geeky stuff lik
also useful stuff like the length and default BPM.

When you toggle down the individual audio and video properties, you get
finetuning options.



Audio Properties

The audio properties are only visible if your clip has an audio track. Duh

Use the X button to delete the audio track. You can use this to remove tf
if you do not need it.

Using the audio properties, you can set the volume for this clip individua
balancing the volume of clips that will play on a layer. Also, you can pan

Video Properties

TipDrag a video clip from the browser over the blue video area. This allc
but keep any effects and parameter changes you had applied to the origil

Use this bad boy to resize the clip to the size of the current composi
your content isn't at the right size already.

Clicking this multiple times will cycle through a few options available for

e Fill. This will make sure the clip fills the entire composition, while m
This will result in the sides or the top and bottom of the clip being c¢

e Fit. This will make sure your clip is completely visible, while maintai
will result in black borders being visible on the sides or top and bott

e Stretch. This stretches the clip to the composition width and height,
necessary.

e Original. This returns the clip to its original size.

Click this to clear the video from the clip, leaving the audio intact.

Use the RGB toggles to subtract colour channels from the clip. L
these, you can quickly colorise a clip to the three primary Red, |
as the secondary colours Cyan, Magenta and Yellow.

The A toggle can be used to disable transparency in a clip. This will only
an alpha channel in it.



When you fold open the extended properties, you get access to Opacity,
Mode and Alpha Channel interpretation of a clip.

Opacity

This will fade out the visibility of your clip, gradually fading it to black.
Width & Height

Here you can change the resolution of the clip using exact pixels.
Blend Mode

This will let you set which blend mode this clip uses when it's playing in
whatever blend mode you have selected on the layer, for as long as this

Alpha Type

Here you can tell how to interpret the alpha channel information in your
to "Premultiplied". This is the default setting that After Effects uses for
channel. So most of the time, you don't even have to worry about this.

Are you seeing a weird halo around your edges? Then you probably want



Layers

Think of your composition as a painting, and you're creating 60 artworks
a layer of paint on your canvas.

We start at the bottom, with a blank canvas. Layer 1 is the first layer of
add Layer 2, then Layer 3, slowly adding more and more layers on top of
masterpiece.

Or a great big mess. Sometimes both. It's your little world, and you can |
want it.

Some people think that the first layer should be at the top. | guess that's
book starting at the top left of the page (in a Western culture anyway).

However, it's very rare to start a painting by applying the top layer first,
paint underneath. Since we're artists painting a masterpiece, and not wri
layer is the bottom layer.

Blending and Compositing



The first layer of paint is always applied on black. It will fill the entire c¢
control over how thick you apply the paint. Simply grab the 'V' slider to f
Similarly, if you're playing audio, you can use the '"A' slider to fade the ¢
'"M' slider to control both at the same time.

The fun really starts when you start blending layers together. Blending i:
The new layer of paint will blend with the paint that's already there. This
can be blended with the ones below it, in a variety of ways.

The default blend mode is '"Add'. Using Add, you simply add the new laye
one, adding the pixels together. This is a great way to mix clips together
background.

Don't care about math? Feel free to skip ahead. Still here? Great. Black
and adding zero to something doesn't add anything. This is why black pix
using the Add blending mode. Also, you're a nerd. Who likes math? Serio

Too Much of a Good Thing

Of course, you can have as many layers as you like. Or at least until sm¢
your computer.

New layers can be added with the Layer > New and Layer > Insert menu c



adds the new layer to the top of the layer stack while the Insert options
below the currently selected layer. If you're a shortcut type of person, yc
on a Mac) to add a new layer as well.

This is a good moment tocballp ceshbiwtas in how you compose your overall v
output.

It's very easy to keep stacking layer upon layer, but as the saying goes,
can already be more than enough. A good composition gives each layer r
smearing every pixel shut.

The danger with Add blending is that, well, there's no other way to say it

When using as little as 3 layers together, the result quickly becomes a \
great, but it's not very nice to look at. Also, when you're playing on a LE
front are now acutely aware of how silly they look and that that one boy |
actually a speaker with a coat hanging from it.

Luckily, Resolume has many different ways to blend, including ways to m
instead of brighter.

You change the blend mode by clicking on the dropdown marked Add, and
big list. Let's go with Darken for the second layer, and Dodge for the thi

There, much better. We can still see the texture and design of every laye
overwhelming.



Alpha Blending

By far the cleanest way to paint is to use content with an alpha channel.
have transparency baked into them, so you can stack layers on top of ea
the paint. This way, you can precisely control which pixels to show and v
the overall composite stays crisp and clean.

Most of the content you purchase in the Resolume shop has an alpha cha
doesn't, you can use the Auto Mask effect to turn the black pixels transp
around with the Contrast parameter to get the desired result.

A good way to approach a composition with alphBaclkanpehsd i Focwse/a
Frameapproach.

Your first layer wilBdekgpaundou use this layer to paint the entire canvas
filling loop. This gives your composition texture, and a base to start with
kind of pattern are great for this.

On top of this, you use the second layer to paint a more recognisable ele
viewerlrscusFaces are always a winner, but you can use anything that has
the music or theme of the stage. If you're commercial oriented, this woul
DJ's logo.

The third layer will breraamedhtd’'s underneath. The layer will be used as a
blocking some parts of the content underneath. Often used in movies, blc



gives a sense of depth to the overall composition, and constantly hiding
composition keeps everything dynamic.

Of course, nothing is stopping you from using more layers, or even using
more complex stage design.

Types of Blends



Unfortunately, this manual is not long enough to go into de
blend mode does exactly.



Blends

These will blend and mix the paint of your layers. At 50% opacity, they w
the layers underneath. At 100% opacity, they will just fully cover the pai
putting a completely new layer of paint on your canvas.

Some blends will create a brighter output, like "Add', 'Lighten' and 'Scre
output, like 'Subtract', 'Darken' and 'Multiply'. Some just do weird stuff |

It's best to just sit down, grab a cup of coffee or tea and try them all out
they do. Remember to try them with different types of content, as that ca
results, depending on the blend.

50 Blends

These are special types of blends. They do the same as their regular cou
mix their paints with the opacity at 100%. They're especially useful for d
you can have both the audio and video sliders all the way up. Or if you Ii
faders all the way open like a superstar DJ.

Transitions

Some blends are actually transitions. By fading the layer from 0% to 100
is applied.

For instance, 'MultiTask' will do a Cover Flow type of transition, where t|
from the side and push the layer below to the back. 'Shift RGB" will bring
channels of the new layer in from the left, right and top.

Transitions work best for presentation type of shows, but for instance 'to

bring in a new layer with a bang during a VJ set.

Eject, Bypass and Solo

These three bad boys can be found on the far left of the layer strip.
The X will eject the currently playing clip from the layer.
The B will bypass or Blind the layer, temporarily hiding it from view.

The S will Solo the layer, hiding everything but the current layer. This is
layer when troubleshooting, or as a visual effect during show to emphasi

Be careful you don't end up in a BS situation, where you both Solo and B
then you end up with a whole lot of nothing.



Layer Order

You can change the order of layers simply by dragging a layer by the nar

where you want it.

Layer Transition

Layer Transitions will let you add a transition when you trigger a n
way you can smoothly blend from the old playing clip to the new on

The auto layer transitions can be found by choosing View > Show Layer T
they will pop up to the left of the clip thumbnails.

Once visible, simply fade up the vertical slider to set a transition time b
you like numbers as much as | do, you can also set the transition time pr
millisecond in the Layer panel.

The transition mode will default to Alpha, which is a simple crossfade. If
can choose all of the available blends and transitions instead. 'Twitch"' it
'Cube’ is amazing just for sheer corniness.

If you really can't decide on a favourite transition, there is also a randor
different transition every time you trigger a new clip.

Previous / Next Clip

Yes! These buttons will let you trigger the next or previous clip in
also assign MIDI and keyboard shortcuts to these buttons.



These buttons come as a bonus with the Layer Transition Controls, and c
Show Layer Transition Controls.

Layer Properties

To select a layer, click the area that displays the layer's name, for exam
selected layer is highlighted in blue.

Auto Pilot

This will let you play a sequence of clips in a layer. When the current cli
Resolume will trigger the next, previous or a random clip automatically.

TipClicking the Next, Previous or Random button before the current clip |
the Auto Pilot to do its thing prematurely. Don't worry about it, triggering(
everybody. You were probably just nervous.

The Auto Pilot can also be s2t ordnthbkat case, you have the extra option t
first, the last or even a specific clip in the layer directly.

Common

This contains the Master fader for the layer. This fades both the playing
same time, without affecting their individual levels.

Audio

This will let you control the Volume and Pan of the audio playing in the |



Video

Here you can choBsenth®dModedpacitpf the layer. These controls are the s
be found on the layer strip at the top.

Width & Heightkl let you change the resolution the layer renders at.

TipLowering the Width & Height can save you considerable render power.
7680x4320 composition, with four layers each set to 3840x2160, position
layer will only process at the resolution its set to, instead of processing

Auto Simegreat to make sure your content always matches your layer size
content to automatically Fill, Fit or Stretch to the layer size.

e Off will keep the content as it is.

e Fill will make sure the content fills the entire layer, while maintainin
result in the sides or the top and bottom of the clip being cropped of

e Fit will make sure your content is completely visible, while maintaini
will result in black borders being visible on the sides or top and bott

e Stretch stretches the clip to the layer width and height, distorting th
necessary.

Layer Transport Controls

The Layer Transport Controls give you quick access to the tra
clip currently playing in that layer.

These will let you quickly change the speed, direction and loop mode of
the playhead and scratch it. When in BPM Sync mode, you will see the ar
the speed.

Practically, these controls can also be found on the transport section on
see and control more than one clip at the same time. Changing anything
update it in the other.

You can show and hide the Layer Transport Controls via View > Show La)



Trigger Options

These will set particular trigger options for all clips in a layer. They can
individual clips on the clip level.

Ignore Column Trigger

With this enabled, any clips in this layer will keep on playing when a col
useful to keep clips like live inputs or background around, but change all
single click.

Trigger first clip on load

After the composition has finished loading, the first clip in the layer will
After this, any Auto Pilot actions will be executed normally. You can use
with Resolume, or to quickly get a test card up and running when you lau

Fader Start

This will retrigger the current clip, every time you bring the opacity up.

Mask Layer

A layer can be set to Mask Mode, mask
all the layers below, or just one layer.

In Mask Mode, the layer will use the black and white values of the conter
layer to show or hide the layer(s) below. Alpha will be treated as black.

To give a visual indication of what's going on, Resc

the thumbnails in greyscale. Also, it will show a litt

transparency checkerboard, as a visual reminder th
currently being used as a mask.

All Belowill apply the mask to all the layers below the Mask Layer. It's ec
setting the layer to Mask50.

One Belawll apply the mask to just the layer right underneath the Mask L
other layers unaffected. If you're familiar with After Effects, it's the sam
Track Matte.

Disablewill set the layer back to be a normal layer again.



Lock Content

This will let you lock the content currently playing in the laye

All this does is make sure that you cannot accidentally eject the current
clip into this layer. Both the layer and clip parameters can still be contrc

As a visual indication, a lock icon is displayed over the layer thumbnail.

Duplicate, Rename, Clear and Remove

Of course, you can Duplicate, Clear, Remove or Rename a layer as well.
what Duplicate does.

Rename is kind of special. Obviously, you can use it to rename the layer

It's special because you can use # as a special character. When displayi
replace the # character with the current position the layer has in the sta:
the layer "L# Mask", will display the layer name as "L3 Mask", if it's the
Moving the layer up or down will automatically update the displayed nam¢

The difference between Clear and Remove is that Clear just clears out al
but keeps the layer itself around. Remove will get rid of both the content
swoop.



Groups

Groups are available on Arena only!

Sometimes, you have a set of clips that work particularly well together. )
three clips that, with just the right blend mode, melt together to become
content. Wouldn't it be great if you could control those clips with one fac
they were one clip, and could even move them around and scale them like¢

That's where groups come in.

Groups are essentially little sub-compositions. You canh use them to grou
them as one big, new layer.

Creating Groups

You create a group by selecting the first layer you want to add to the grc
selecting Group > New.

This will put the layer in the group. You will see this reflected in the int
slightly indented, and the newly created group will "hug' its new baby. Al
appear next to the layer panel.



Adding and Removing Layers

At this point, adding and removing layers to and from a group is very eas
them by the layer name handle, and either drop em in, or throw them out.

Keep in mind! A group canh never be empty, as this would mean the group
could lose all its effects and settings. So when you drag the last layer ol
will create a new empty layer in its place.

If you're more of a menu type of pers
can also use the layer menu to move
of groups.

Group -xIf another group is available, selecting it will move the selected
None- This will remove the selected layer from the group.
New- This will create a new group and put the selected layer in it.

You can create as many groups as you like.



What Happens in the Group, Stays in the Group!
Groups are a hybrid between a little sub composition and a layer.

They have a lot of the same functionality that th
has. Groups have their own little column trigger
little master speed slider and playback controls,
own master bypass, solo and eject buttons.

Of course, you can apply transforms, effects and masks on the group lev

Groups also borrow some functionality from layers, like Ignore Column Tr
applied on all layers in that group.

The only difference is that what happens in a group, never leaves that gr

On the one hand, this means obvious things like that group column trigge
outside the group, and pressing the group eject button, only ejects layer

But it also means less obvious things.

For instance, you can't route layers to a Layer Router outside the group,
a layer in a group if the group itself is on another crossfader bus. This p
accidentally tearing a hole in the space time continuum. Because that's v
start doing weird things like that.

And no, you can't put a group in another group. You are not Leonardo Di¢
asleep in a van falling from a bridge in Paris.

Group Blending
Groups start you out with a blank canvas.

Regular layers will blend with the layers beneath them, depending on the
opacity. Layers in a group only blend with the other layers in the group.

The first layer of a group is first rendered on a transparent black backgr
the layers underneath it. The other group layers are blended on top of th



The final result of this is then blended back in the composition. The grovu
flattened layer at this point. You can use the group's blend mode and op:
mixed with the rest of the composition.

Groups default to Alpha blend mode with 100% opacity.

Group to Slice Routing

Groups are also available as input for slices in the Advanced Output. Thi

layers to a single slice.

Keep in mind that you can no longer use the group blending mode at this
group to a slice means you bypass all composition effects.



Composition

The composition is your complete performance. It's how you've arranged
layers, the effects you've applied and how you've set everything up to be
composition as your stage. It's where you arrange where everything goes
looks.

Your composition composites all your layers together, applies the final e
your screen. If you're an advanced user, you can use the Advanced Outp!
warp your composition. Or you can send the end result to other applicatit
to further process it.

Settings

Via Composition > Settings, you can change a few important details of yc

Name

This is how you will recognise this composition. It's also the filename Re
disk.

"You have strength. You shall be known as Usul, which is the strength of
is your secret name in our troop, but you must choose the name of manhc
you openly."

Description
Here you can jot down some notes about this composition, which will be
Size

The resolution that your masterpiece will render at. Via the dropdown, yc



common resolutions, the resolutions of currently connected monitors, or
resolution directly.

FrameRate

This will limit Resolume's fps to a fixed maximum.

Onauto Resolume will sync to your monitor's refresh rate. So if your moni
Resolume will render at 60 fps. Rendering more would be silly, because \
to display those frames, and they would be thrown away.

This is the setting that you'll want to use for the majority of the time.

When you're pushing very high resolutions or when using lots of effects,
computer can't keep up with what's going on. In those cases, Resolume w
60fps, but it will start dipping. Depending on how hard you're pushing thi
fluctuating between 40 fps and 60 fps.

In those cases, it can be smart to limit your framerate to 30fps. That way
the same time to render. This way, playback will be perceivably smoothel
will be equally divided between on and off, instead of stuttering because
at one moment and 57 fps the next.

TipFor super smoooooth playback, you'll want to match the framerate of \
framerate of your content. 25 fps clips will play silky smooth when the cc¢

Note! When your computer cannot keep up and is rendering at 23 fps, put
does not give it magical powers. It will still have to do the same amount
hardware, so it will struggle just as much as before.

Bit Depth

This will let you switch between 8 bits per channel and 16 bits per chann
you higher color fidelity when doing complex composites or applying intri

TipWith great power comes great responsibility! This is not a magical sw
better. When set to render at 16 bpc, your computer will need to work co



production workflow is not 16 bpc, you are not likely to see an immediate

Properties

In the top left of the interface, you will find a few powerful controls.
TheCompositibmtton will let you preview the composition, even when it's f
TheX button will let you eject all playing content in one click.

TheB button bypasses the entire outMustlidelrilgivbe you the same control un
fader.

TipBecause the M slider controls the visibility of everything going out of
not set to 100%.

The&s slider controls the speed of all playing clips at the same time. Note
control has no effect on BPM-synced clips, as those are controlled by the

The two arrow icons will let you trigger the previous and next columns. Y
Common

Here you can control the master opacity of the composition and the spee
same time.

These controls are linked to the ones above. In the composition panel, yi
because you can both set and see the values numerically.

Audio
Gives you control over the master volume and pan.

Video

Fade out the video, independent from the audio.

Crossfader



The crossfader will let you assign layer
groups to a 'bus', and then fade betwee
This way, you can put layers that look ¢
together on either side of the crossfade
between them quickly using a single sli

You assign layers to a bus, by toggling the A or B buttons to the right of

Resolume will then composite those layers together first. When the cross
left, it will only show the layers on the A bus. When it's on the right, it w
bus. When it's somewhere in the middle, it will blend the two buses toget

In the composition panel, a few options can be set for the Crossfader.

Blend Mode

This determines what blend Resolume will use to composite the buses tog¢
one of the many blends that are available.



Behaviour

This determines what happens when you press the A and B buttons to the
crossfader itself.

Jumpwill make the crossfader go to that side immediately.
Jump & Retwrihl do the same as Jump. When it's clicked again, it will

side.
e Cutis like Jump & Return set to 'piano', meaning it will return to the
released.

Fade (LegawV¥l)do a slow fade to the clicked bus over 4 beats.

Curve

This sets a different mixer curve, changing the respons
crossfader.

Gotcha!

For the crossfader to work properly, you'll want to have all bused layers
another in the stack.

The Crossfader is an actual mix. It renders all the layers assighed to bu:
pulled down to the first layer present in the crossfader and rendered dow
composition stack.

So when you're combining layers assigned to the crossfader with layers r
crossfader, you might get unexpected results. Things get especially weil
are in between assigned layers.

Direction Controls

With the global direction controls, you can quickly change the
clips that are currently playing. You can switch the direction
backwards, as well as set them all to random mode.

TipBy right-clicking the button you can 'pin' the direction controls. That
automatically be set to this play mode. So when you right-click the R but
clip you trigger will be set to random playback, regardless of how it was

You can find the global speed and direction controls by choosing View >



Controls, they then appear in the top left of the interface.

Trigger Options

These are essentially the same as the . Except here you can set the
all the clips in this composition. You can imagine this saves a lot of time
every clip individually.

Of course, these setting can then again be overridden by individual clips



Decks

Each composition can contain a number of decks, which you can use to m
images, audio files and sources.

Decks are like the records in a DJs record bag. Keep them organised so
right selection.

Decks are accessed through the set of buttons just below the clip layers.
When you select a deck, all of the clips in the deck are displayed in thei

Tipllf you're really adverse to clicking with the mouse, you can assign sh
the far left of the deck area and scroll through.

Adding Content

Before you can start having fun with your content, you need to get it into
by dragging and dropping files from your operating system file browser o
Resolume's built-in browser.



You will find the browse
over to the right of the
display, in the Files tab

The main part of the browser enables you to browse through folders by d

Tipllf you need to search through a long list of files and you already kno\
you're looking for, type the name into the search box to narrow down the

Click the dropdown at the top to show a list of root drives on your systen
favourites. You can add or remove items from the favourites list via the |
right.

Next to the heart is a toggle that enables you to show or hide thumbnail
really useful when you can't quite remember what you called that fantast
Also, you can double-click a clip name to preview it in the preview windo
that it is the fantastic clip you made last night.

Loading media into a clip is simply a case of dragging it over to a slot in
audio file and a video clip or image file onto the same slot to make a cor



Resolume will automatically transpose the video to the length of the audi
clip.

Check out the for tips on optimising your content for Resolum

Managing Clips
Think of clips like words in a sentence.

Just like using different words can drastically change the meaning of a s
clips together can drastically change your output. Sometimes some words
sense at all. So you also want to keep clips together that, when used tog
awesome.

This is where decks come in.

When you have some clips that work well together, you put them in a sing
keep them together and always access them.

You can arrange clips by theme ("all the space clips"), color ("all the blu
slow clips"), type ("all the audio-reactive clips") or whatever you think m

The point is that managing your clips is super important to playing a goo

TipThe same clip can be used more than once in another deck, or even m
deck. This way that trippy kaleidoscope clip can be part of your '"Psychec
deck and also your 'Backgrounds' deck.

Once clips have been added to a deck, you can move them around by clic
name below the thumbnail of each clip. If you drag a clip over an already
places in the deck. You can also drag a clip just to the right or left of an
dragged clip next to it, and shift over the others to make room for it.

If you want to copy a clip, drag the clip to the new position and then hol
Mac) as you release the mouse button. A copy of the clip will be created
remain. You can also use the universal copy, cut and paste commands CT
equivalents on a Mac), allowing you to paste a clip into a different deck
shift and CTRL/CMD to select multiple clips and copy/paste multiple clip:



TipA good way to organise content is to have similar clips nexiAtbagach o
is a horizontal row of clip slots. This way, you can easily select differen
theme.

You can also organise your content so that clips that look good when pla
column. A column is a vertical row of clip slots. Then you can play them
the column, using the column itself as the trigger.

Using Decks

Instead of loading a whole composition with all its decks, single decks c:
composition as well. Just double click the deck in the Composition brows
the current composition as a new deck.

Very useful for those inevitable moments half way through your set, wher
playing content you didn't prepare.



A good way to be prepared for th
moments, is to keep one or more
'master compositions'. These mas
compositions are not meant for a
performance, but rather contain vy
footage, pre-organized per theme
instance, one master comp could
all your 1080p material.

Every time you have some new 1080p content, you open the 1080p comp .
the new material. Or you could, of course, add the material to already ex
theme of that deck.

At this point, you can also set clips to be BPM Sync or Timeline, apply e
clips together in columns.

After you've added the new footage, save the comp, close it and leave it

Then, during performance, when you realise you feel like playing a certa
have to search your computer for them, or add and set them up during sh
click its deck in your master comp, and it will load for you in your curren

the clips in the right place with the right settings.

Organising Decks

A new deck can be created by using the Deck > New
Insert Before or After menu options. The New optio
deck to the end of the list while the Insert option a
after the currently selected deck. You can also dup
deck.



To change the order of decks, just drag em around.

Closing a deck will remove a deck from the current screen, but keep its c
remain part of the composition. It will remain closed until you open it ag

Clearing a deck removes all its contents, but keeps the empty deck open
delete it in its entirety.

By default, when you add the first file to a deck, it will get the name of t
file. If that doesn't mean anything to you, you can use the Rename optior
meaningful name.

You can also use color coding to mark your decks more clearly.



Video

Resolume supports loads of movie formats.

Can Resolume play my videos?

That's a simple guestion. The answer gets complex real quick, depending
want to get.

Let's start with the simple answer:

On Mac and Windows, Resolume supports

e MOV files

e _AVI files

e .GIF files

e MP4 files.

e MPG and .MPEG files

So if your movie ends in one of those extensions, you're in good shape.

Of course, with computers things are never as easy as that. The file exte
everything about that file. It doesn't say anything about which 'codec' is
codec is actually the most important part about playing video.

So let's make it a bit more complex.

e If your system's video player can play it, so can Resolume.

The rule of thumb is this: If your file opens &haviEays dppWwin dpwse's
Quicktime iX's going to play in Resolume. This means it supports most co
h264.

If you need to use VLC or some weird codec pack to see your file, chanct
your file. If Resolume can't play your file, it'll display it with a big yello:

Tiplf you have trouble playing a file, converting it to DXV is always, alwze
problem. Need help with that? Read ail about



#Nerd alert!

Now if you're a bit technical minded, you probably want to know the nitty
are supported. If you're just here for playing cool videos and actually ha

When Resolume opens a file, we first try to open it ourselves. When we s
encoded, we use our own player. This means you get hardware accelerate
with DXV, and turbo fast playback on Photo-JPEG. Also GIFs are played |

If we don't recognise the format or codec, we pass it to the big boss, yol
system. On Windows, we ask MediaFoundation. On Mac, we ask AVFound:
if they can play the file. If they can, we let them handle it for us and jus
back. Letting the system handle things means you get some cool benefits
h264 on OSX.

If all that fails, we finally ask FFMPEG if they recognise what's going on
of it.

Unfortunately this doesn't mean that we support the full range of codecs
licensing for FFMPEG is actually very complex, and unless you're an ope
you are not allowed to just play all the codecs. When you stick to these |
limits to FFMPEG. And we like to play by the rules.

Playback

Resolume provides loads of ways to control how videos behave.

The Transport section of the Clip tab is where we can change the speed .
at.

Timeline

The first thing we will look at in the Transport section is the timeline its
directly by grabbing the blue pointer that moves along it and sliding it ar
similar to DJ scratching.

The smaller bar below the timeline is also useful. Grab and move the sm:
to set the In and Out points of the clip. This is great for selecting parts

TipAfter setting in and out points, hold down Shift while dragging the ran
range around, while keeping the length the same.



In the top right, you can see the current time of the clip. Clicking on thics
you the remaining time.

You have direct control over the Speed of the clip. You simply use the S|
up or slow it down.

BPM Sync

There is another very powerful way to control the speed of a clip. You ca
down at the top right of the Transport section. It's called BPM Sync and

By switching the transport mode to BPM Sync, Resolume will use the glot
speed of the clip. You can read ail about . For now, let's assume you h;
Resolume running at the perfect BPM, perfectly in time with the DJ. Now
transport mode set to BPM Sync will play at a speed that synchronises th

In order for BPM Synced clips to work right, you will need to set the num
spans in the Transport section. By default, Resolume will guess the right
based on the length of the clip. It will guess to the nearest power of 2, s
8, 16, 32, 64, 128 etc beats for you. Of course, you can click the number
- buttons or use the *2 and /2 buttons to quickly multiply or divide the ve

SMPTE

On Arena, videos can also be set to SMPTE. That rabbit hole is sc¢ d=ep,

Playback Options

The Transport section also provides some additional options:

Use these buttons to set the clip to play forwards or backwards, or pause
The Random button can be used to jump to random frames in your video.
the Speed slider now controls how often the clip will jump to a new frame
mode, the clip will randomly jump to a random beat and continue playing
random. Much wow.



Use these buttons to control what happens when the clip reache

The default mode is to loop, which will just start the clip from the beginn
for ever and ever and ever. The second option is to ping pong, which me:
forwards and backwards. Ping pong is a cheap way to avoid a visible cut
actually loop.

Next is play-once-and-eject. You can use this for 'one shot' samples that
mix. The play-once-and-hold mode will hold the last frame of the clip whe
useful for stuff like logo reveals and DJ intros.

These buttons decide what happens when a clip is triggered. The
plays the clip from the start. The second option, "pick-up", start:
it was when it was last played.

The third option, "relative pick-up", will start the clip at the same relativ

played clip was at. | don't really know what you would use this playmode
because Resolume 2 had it and he used it with crash test footage of diffe
change cars mid crash or something. | guess that must have been like pr

Like, whatever.

Tip!So, people smarter than myself have figured out that this relative pic
backup during SMPTE playback. The idea is you have two copies of the ¢
the other to regular timeline and relative pick-up. Should the SMPTE sigr
can switch to the copy. It will pick up where the SMPTE clip was and nob
happened.

BeatLoopr

You can tell the Beatloopr is special because we've written it without an
from the nineties that were down with the hip lingo of the kids these day!

When a video is set to 'BPM Sync', the BeatLoopr section is displayed. T
Resolume automatically loop sections of the clip. This is great for adding
vocal combinations or all kinds of other effects.

To use it, just select one of the options - the clip will loop over the rele
you are done, just click the selected option again or the Off button. It's

With 'Catch Up' active, turning the Beatloopr off will continue playback w
have been if you hadn't used the Beatloopr. Otherwise, it will just contin
was.



Cue Points

You can use the Cue Points section to quickly jump to any part of the cli

To set a cue point, click the smaller part to the left of one of the cue po
click will turn blue and the letter on the main button will turn white - thic
ready for use.

Now you can click the main button (or press the relevant keyboard key) t
point where you set the cue point.

If you want to set cue points precisely, a good way to do it is to pause t}
timeline marker to where you want the cue point and then set it.

You can reset an existing cue point in exactly the same way as setting it

TipThe Beatloopr will automatically turn off if you jump to a cue point. T
build a climax using the Beatloopr and Cue Points. During a climax mome
choosing shorter and shorter loops until the beat drops again, and then j
to resume normal playback at. Reach for the lasers!



Stills

Resolume can also play still images.

It can load and display:

e .png files
e .jpg and .jpeg files
e . tiff, and .tif files

Options

Once a still image is loaded, you get a few options for playback.

Transport

Just like a regulaa still image can be played back in both Timeline and B
This changes what timing the still uses. In BPM Sync mode, it will use th
Timeline, it uses Resolume's own internal clock.

Aside from this obvious difference, it also changes how you set the Dura
Duration

In Timeline mode, the Durasimanondset in

You can use the + and - buttons to nudge it, or just type in a value direc
TipThis also works for multiple clips at the same time!

In BPM Sync mode, the Duradeartsis set in

You can use the + and - buttons to nudge up and down by 1 beat, use the
to multiples, or just type in the exact number of beats directly.

Wait... What?

"Hold up, Resolume. Why are you going on about all this seconds and be



is a still image we're talking about. It has no duration! It can't go faster
‘going' in the first place."

Yes. You're right. When left to its own devices, stills are literally infinite
has no visible impact.

That all changes when you start using them Imithhdabe cases, the Duration
control how long it takes before the next Auto Pilot action is triggered.

Also, when you really get down to the nitty gritty details, this also affect

On Arena, you can even sync stills to SMPTE.

It's almost like stills actually have a sort of timeline after all.

Triggering Stills and Memory

Contrary to what you might think, playing back a still image is actually s
intensive. Although it's just a single frame, this frame has to be loaded i
before it can be displayed. This is for instance why Photoshop gets so sl
a PSD containing lots of high res stills.

Because Resolume doesn't limit the amount of files you can load, it woul
load lots of high res still images. Dragging in a few megapixel TIFF files
would eat through your available RAM in no time.

This is why we do something called 'deferred loading'.

This is a fancy term that basically means you can load as many stills int
will only use RAM at the moment you actually trigger them. This benefit
can be a slight hiccup when triggering a still file. A few 1080p images is
become more noticeable when you start using 4K or above resolutions.

So if your VJ style depends on lightning fast triggering, it's best to avoic
better to convert them 10 shori

If you're using stills as part of a larger composition that doesn't rely on
name or a background image, it's perfectly fine to use stills. As far as pl
not quicker or slower than regular movies.

More than Content

A great thing about stills is that they can abgoalse us=2d as



Sources

Sources are very similar to effects.

The difference is that, while effects change existing audio or video, Soul
on the fly.

Because they generate content, Sources need to be loaded the same way
audio or video content file.



To use a source, drag it from the Sources panel on the right of the scree
Let's drag the Rings Generator to an empty clip slot.



Source Properties

Once placed, the properties for the Source will be available in the Clip t

All Sources have a few shared properties.
Duration

Like Stills, Sources have a Duration. This can be set in seconds or beats
mode. This can be used to include ihe $SosreRuiem aa.

Transform and Composite

Sources also have the regular options to Scale, Position and Blend the c
Still file.



Source Specifc Properties

Every Source has a few properties unique for that Source.

For instance, Rings has a few obvious ones, like the number of rings, the
of the rings. It also has a few less obvious ones like Gap and Style.

The Line Scape Source will have completely different parameters again.
head around these is to just play around with them and see what you like

When you find a specific look that you like for a Source, you can save th
dropdown in the top right of the Properties.

Text Animator

The Text Animator is a very powerful Source. As the name would suggest
animate text on the fly.

It has quite a few parameters, luckily most of them speak for themselves

TextFontStylegoloman®&izean all be used to change the look of the text, ani
text itself.

AlignmeandPosition X am@énmtrol how the text is distributed over the screer
multiple lines are aligned to each other.

Spacing X ameéntrol the Tracking and Leading of the text respectively. Th
typographist words for how far apart the letters are horizontally and vert
words.



Animate

The fun with text really starts when toggle on Animate and twirl down its
up a world of possibilities for per character animation.

Every parameter you change here will affect every character, based on c:
grab the Scale param and give it a bit of a wiggle. Awesome right?

It gets even better when you realise that you can also animate these par.
animated animation.

Using thelayarameter, you can change how long it takes for every charac
changes.

The Order lets the delay move from Front to Back or Back to Front throucg
affect characters randomly.

Finally, by chan@iaggey®ou can let the animation affect every character, e
line or just the whole text.

Routing

The Video Router allows you take the output of a single layer
the router into another layer. On Arena, groups can also be |

This can be useful for complex projection mapping setups or to simply di
simultaneously with different effects.

The preview window output can be selected as an input as well.



Input Opacity / Bypass
The toggles for Input Bypass/Solo and Input Opacity are only functional \

group is selected as input. They serve as a pre-fader / post fader switch

For instance, when Input Opacity is disabled, the router will continue to
when the input layer's opacity is faded down. This is useful to avoid renc
layer on top of itself.

Capture Devices

Capture devices are used to take input from other hardware into Resolum
laptop's webcam will show up as a capture device.

You can read all about capture devices on.the

NewTek NDI/Spout/Syphon

These are essentially virtual video patch cables. They're so awescme the
in the manual.



Live Inputs

Live inputs will show up in the Sources tab.

Most laptops have a webcam, so on laptops this is usually the first optio
you have connected will show up automagically.

To use a live input, simply drag it from the list on an empty clip slot. It \
can trigger and eject. Like regular clips, you can change its properties,
composite it with other layers.

Capture Devices

To go beyond the basics of a webcam, you can use a capture device. Cap
shapes and sizes. Some are external boxes that connect via USB or Thun
built in to your computer.

A capture device will take a regular video cable like HDMI, SDI or compo
that Resolume can use. You can connect a proper broadcast camera via ¢
Then you can use the input in Resolume to make PIPs or further process

Of course you can also connect a computer's output via HDMI, and use it
output, or a speaker's Powerpoint presentation.

On a Mac, video capture runs via AV Foundation. On a PC, we use Direct
your capture device with simple capture applications like Quicktime X, O
work in Resolume.

Native Capture Support

Aside from using the system capture system, Resolume also has native s|
capture devices. This means you get maximum quality with minimal laten

Native support means that Resolume gets the image directly from the dev
processed by your computer's CPU first. Skipping this step means that th
output is a low as possible.

How low latency is low latency? That depends on the resolution, frameraf
device and your computer hardware. For devices connected via PCle or T
expect something in 60ms-100ms range on 1080p60. For USB3.0 devices,
ballpark figure.

TipZero latency is a pipe dream. You will get the lowest latency by conne
the display device. Even then, your display hardware will introduce a litt

We support capture devices from

e Blackmagic
e Datapath
e AJA



Native support means that you can use multiple devices at the same time
multiple inputs, you can use all those inputs at the same time.

If your device supports it, Resolume will autodetect the connection, reso
framerate it's currently using.

If your device does not support autodetect, you will need to enter these |
mind that this is an exact science, and when your capture settings don't
settings, your capture device is not going to do much.

Additional Settings

Every card will have specific options for that car
try to set these automatically wherever possible.

Some options are not automatic and are up to personal choice. All interlz
interlaced to fix jaggies.

Blackmagic and AJA cards will let you specify the Color Space and Rangce
with guest VJs that don't know how to set their HDMI black level correctl

AJA will let you decide the source of its genlock sync, and even how man
buffered.

Troubleshooting

Native support does not mean we can magically make a capture device dc

When having problems with a device, the first thing to check is whether t
software can correctly see the input. If it does not show up there, you ar
unsupported video signal.



For instance, Blackmagic expects broadcast specification signals, and if
exactly the correct resolution and framerate, it might ignore it altogether

Only one application at a time can access a capture device, so, make sur
software that might access a device, before trying your feed in Resolume

Magewell

Magewell is a Chinese company that makes very popular capture devices,
Resolume via DirectShow on PC or AVFoundation on Mac.

We'd love to add native support for Magewell devices. Unfortunately, Mat
single SDK that works on all their devices, and we cannot add native sup



Syphon, Spout and NDI

Syphon (Mac), Spout (PC) and NDI (both Mac and PC) are great tools to

one program to another.

Syphon/Spout

Syphon and Spout work on the same computer. The output of one applica
another. This way, you can for instance get jiggy with your funky Proces:
effects and map them to a surface with Resolume Arena.

There's no hard limit to how many applications you can connect like this.
computer will just start smoking.

NDI

NDI works over the network. So you can send the output of Resolume run
Resolume running on a different computer, without the need for extra har

network connection will work.

Using NDI, you can send video from a Mac to a PC and vice versa, no prc
and Spout, there's no hard coded limit to how many connections you can

network bandwidth will get full at one point.

Input
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Resolume.

Any program that is sending its output will show up under the sources tal
deck like you would any other live input.

You can use as many inputs at the same time as you want.

Qutput



The moment Syphon, Spout and/or NDI is enabled vi
Menu, Resolume will immediately start broadcasting
output as well.

Other Syphon/Spout enabled applications running on this computer will n
composition output.

Computers on the same network will now pick up Resolume's composition

For applications that do not auto-detect broadcasting Syphon/Spout serv«
output identifies itself to as follows:

App Name: "Avenue" or "Arena".

Server Name: "Composition" (for the main composition output) or Screen
Advanced Output to route a screen).

NDI Gotchas

Network Adapter

The NDI protocol doesn't currently have a way to select which network in
data. As a consequence, it will use your Wifi when you have both wireles
active. Especially on OSX, it will always default to Wifi when it's availab

As you can imagine, sending video over Wifi is pretty crap. So you'll wan
connection when setting up NDI.

Discovery vs Connection

Another point is that the NDI protocol is known to detect more sources tf
to.

For instance, a computer sending NDI can be in a different IP range from
connected to the same network. This will result in the strange situation t
show up in Sources, but will show a 0x0 resolution and Offline when uset

To avoid this, you'll want to make sure that all your NDI computers are it



subnet mask.

Advanced Output

Resolume Arena allows you to further con
via the Advanced Output. Syphon, Spout
outputs can be treated like a separate ph
screen.

This allows you to warp the output before sending it, or to select parts o
While you can still send a different output to your physical screens.

When sending to Syphon/Spout you can change the width and the height ¢

Syphon Example Code

Example code for Processing:

For Arena:

client = new SyphonClient(this, "Arena", "Composition");

Or for Avenue:

client new SyphonClient(this, "Avenue", "Composition");
If you use a Syphon output via the Advanced Output of Arena, you can naga

client = new SyphonClient(this, "Arena", "Screen 1");



Effects

Effects are super awesome! Everything playing in Resolume can be maniyg
the audio and all of the video.

When you get right down to it, each effect is a small program that chang¢
some way, controlled by parameters. You send this little program whatev
does its magic based on how you have it set up, and then it spits out the

Resolume comes with a whole bunch of video effects built-in, more than
of basic audio effects. If that doesn't cut it for you, you can read more a
effects below.

Using Effects

You can find all of the effects in the Effects tab, which in turn can be fo
the interface.

To preview an effect, double click its name in the browser. It will show il
applied over whatever is playing in the composition. You can then tweak
you can get the look you re after.

If you've found the right effect for the right moment, just drag the effect
the area of either the Composition, Layer of Clip tabs. Drop it right wher
mask here'. You can also directly drop it onto a clip or layer.



TipHold down ALT while dropping an effect to apply it with its opacity tur
you can tweak its parameters, and then bring it into the mix gradually.

Clip effects are applied to the individual clip when it is playing.

Layer effects are applied to whatever clip is playing in the layer, after it
applied.

Composition effects are applied to the final output, after the layers have

All effects can be temporarily bypassed (B toggle) or removed (X button)

If you're an Resolume effect ninja and already know the name of the effe
can type its name into the Search box at the top of the effects browser.
TipHit CTRL-/ (or CMD-/ on a Mac) to focus the box without having to re

Why the '/' key, you ask? Because it's just like hitting CTRL-?, just withc



Audio Effects

Depending on the effect, audio effects can have any number of parametel
they all share. The "Dry/Wet" slider controls how much the affected versi
with the original.

When this parameter is moved over all the way to the right, you hear the
none of the original audio. When its moved to the left, the effect will not

Video Effects

Similarly to audio effects, video effects always have at least two parame
Mode. You use these to mix the effect with the original video. As with mi
combinations of blends and opacity levels can have very different results

To make sure you see only the result effect and nothing but the effect, s
turn the opacity all the way up.

Aside from this, this manual is too short to tell you what every paramete|
how you should use it. You can try them out and wiggle a few of the cont
You'll figure out which ones you like soon enough. Some of our personal
Hue Rotate, Stingy Sphere, PolkaDot, Goo and Particle System.

Mask

M
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e
essentially effects that create transparency in the image. Using a still im

render certain parts of your content invisible, based on the pixels in the

You can create a mask by dragging the Mask effect onto a panel and usir
load an image file. You can also drag a still image straight on a panel di

Once loaded, you can decide how to create transparency via the Channel

By default, this ilsusenhaoc&his means that where ever there are black pix
image, your content will become transparent. Where ever there are white
remain visible. Grey values mean half transparent, and so on.

By changing the ChRedRluemiGreenResolume will use the pixel's R, G or B
instead of the overall Luminance.

When set to Alpha, Resolume will use the mask image's Alpha channel to

Of course, you clanwarlsloe mask.



When the image used for the mask has a different resolution than the cor
stretch it to fit.

Would you like to use moving content for your mask? Take a ook at the
Transform

Transforms are your primary tool for composing a beautiful image. Quite
the right content does so much more for your output than overbearing eff

Transforms are so importani, they got in the manual.

Presets

All effects support the creation of presets. Each preset contains all the
enabling you to quickly activate an effect, set to just the right sweet spo

To create a preset, first get the effect working how you want it. Work the
juuuuust right. Then use the Preset drop down above the effect paramete
As... option.

Enter a name and hit return.

The new preset will now appear in the effects list, under the name of the
preset, drag it onto the Composition, Layer or Clip in the same way as Yy«
itself.

It helps to think of presets as a big oclt&kmow Yaitmayhlaave seen enough
to know where this is going, but stick with me. It'll make sense in a minu

When you apply a preset, the octopus uses all its tentacles to quickly se
right settings in one go. After that it swims away again. The effect doesn
was used to get its current settings. It doesn't even care if the octopus ¢
by setting everything by hand. So, when you update a preset, other effec
preset by their octopus don't get updated with it. The octopus just visits
in a big inky cloud.

Doesn't make sense yet? Well, | tried. Just remember presets are a way
parameters to specific values. Not a way to keep all your effects on the



Multiple Effects

Thus far, we've only talked about applying a single effect. But you can a
want. You can keep going until everything is one big nasty pool of ugly p
out of your computer. Whichever comes first really.

Effects can be stacked together by dropping more than one into the same
will be applied in order, starting with the top one in the slot. Each effect
affecting the output of the previous effect.

You can change the order of the effects by dragging them by the three hc
of the effect name.

Changing the effect order can dramatically change the resulting output. |
apply the PolkaDot effect on a clip, followed by Radar. Looks cool, right"

Now see the difference when you drag Radar above PolkaDot.

The difference is subtle, but extremely important!

First PolkaDot, then Radar.



First Radar, then Polkadot.

TipTransform is an effect just like all the others. So you can stick transf
stack.

Bonus TBelcause Transform is an effect like all the others, you can also s

Effect Clips

Effects can also be added to an empty clip. When you do this, you will cr
used to working with Photoshop or After Effects, you'll know this feature

Any effects applied on an Effect Clip will be applied to all the clips playi
it. This way you can very quickly create a sequence of different looks an
able to swap out the footage on the fly.

Even better, this will allow you to assion to effects, or even fade frol
effect to the other using the layer transitions.

Like Sources, Effect Clips can be assigned a duration as well, so you cal
Pilot too.



More Effects

The built-in effects in Resolume are super powerful, and should cover mc
they're so versatile that a few years ago, we ran a competition to see wh
looking content with them. Instead of creating content with After Effects
with your camera, the only rule was that you could only use the built-in s
Resolume. People made some super amazing coniect, and vou can still

But, still it could be that you have a need for even more. For audio, Res¢
For video, Resolume supports FFGL plugins.

We keep we know about. Note that for Resolume 6 and uj
needs to be compiled for 64 bit.

To load a 3rd party plugin, simply copy the .dIl (PC) or .bundle (Mac) file
subfolder in Resolume's user folder in Documents. Restart Resolume, an
loaded automatically. If you like, you can also add your own custom folde

For VSTs, you can similary add your own folder to scan for VSTs.



Transform

Every panel has a default Transform effect applied. Depending on which
the Transform effect will let you adjust the position, scale, rotation and
composition, this group, this layer or this specific clip.

Parameters

Each Transform effect has several parameters.
Position

Adjust where the content's center point is on the X and Y axes.

Well, actually, *shoves glasses a bit further onto nose.* Aatueddyjnit adju
of the content is on the X anHoY aleisnterrets. and purposes, let's just say P
you can move them pixely things here and there.

Scale

Adjust the size of the content, proportionally to its original size. Expand
you scale the width and height individually.

Rotation

Measured in degrees, this will let you rotate the content around its anch
parameter will let you rotate along each axis individually.



Anchor Point

If you don't know what an anchor point is, think of it like sticking a pin i
you have on your bedroom wall. Okay. Fine. The Justin Bieber poster tha
wall. Whatever, man. No judging.

Depending on where you've stuck the pin, when you now spin the poster,
point. This is exactly what the anchor point does in Resolume.

The anchor parameter can also be expanded.

Multiple Transforms

You can apply more than one Transform!

Transform is available as an effect in the Effects list, and you can apply
chain.

This way, you can do crazy stuff like first scale down and move a layer t
then apply a mirror effect, and finally position the result of this in the b
composition. Options galore!

Any transform you apply after the first one, will have its own Opacity anc
effect. This way, you can control how the Transform blends with the inpu

The very first Transform in each panel can not be deleted.



Transform Presets

Each Transform setting can be saved as a preset. This gives you quick a
that you often use.

Slice Transform
On Arena, you get access to a very special type of Transform.

It's available as an effect under the moniker Slice Transform, but the be:
open the Slice panel via View > Show Slices.

The Slices panel will show you all the screens and slices you currently h



Now, by dragging the Screen onto a clip, a layer, a group or the whole c¢
instantly place content in every slice in that screen.

The Slice Transform effect works with regular slices, polygon slices and
the orientation of the slice, and respects any input masks applied on the

Changing the slice in the Advanced Output will update the scaling of the
Scaling
Fill

By default, the content will be scaled to Fill within the slice. This will fil
and crop the sides or top and bottom if the aspect ratios don't match.



Fit

You can switch to Fit, in which case it will scale the content to be compl
possibly adding empty pixels on the sides or top and bottom.

Stretch
By using Stretch, the content will be warped to match the shape of the sl
Mask

In Mask mode, you leave the content as it is, and essentially use the Slit
show and hide specific parts of it.

Bypass/Solo/Delete

You can use the B toggles to temporarily hide content for that specific sl
that slice and hide the others.

If you don't need content to show in a particular slice, you can hit X to g

If you realise you needed it after all, you can simply drag the slice back
Orientation

You can use the Pacman icon to toggle each slice through 4 orientations:
Horizontally, Mirrored Vertically, Mirrored Horizontally and Vertically.

Layering your Stage

Of course, instead of dragging the whole screen to create the Slice Tran:
drag a selection of slices instead.

This is a great way to assign content to specific areas of your stage. For
DJ name, set to Fit on just the main screen and DJ booth, while showing
it, set to Fill on the main screen and on the tiles on the roof. Backgrount
everywhere, masked on every slice.

Because Slice Transform is an effect, you can use it to apply these looks
you can have multiple instances of a clip, each with a specific look.

Also, you can create presets to quickly recall specific looks and switch b



Missing Slices

Because Slice Transform works with the slices in your Advanced Output,
slice can't be found. Maybe you accidentally deleted it, maybe you've loc

Whatever the reason, Resolume doesn't panic. It just lets you know some
highlighting the slice in red. Any remaining slices will continue to displa

This is done to give you an indication that something is up. You can then
to do what needs to be done to correct it, or just delete the slice from th
anymore.

When you accidentally deleted a slice in the Advanced Output, undoing it
both in the Advanced Output and in the Slice Transform effect.






Output Setup

Unless you are just using the recording feature of Resolume to make vide
will want to route the video from Resolume out of your computer, hopeful

Before you can configure the outputs in Resolume, you will need to set u
computer's operating system. You should do this before you run Resolum
displays to be available in the OQutput menu.

So first we make sure the display or projector is recognised by your com

Setup your computer

Windows

To set up the displays in Windows, open the Display panel via the Contrc
> Display. Alternatively, you can right-click on the Desktop and select Di

contextual menu.

On the settings tab make sure you have at least two displays visible and
having the two screens in 'extended desktop' mode.



Mac OSX

Open the Display Preferences in System Preferences via the Apple menu:
Displays. Then on the Arrangement tab make sure 'mirror displays' is tur

separate displays on your computer.



Setup Resolume



Now start Resolume and check out the Outp
The Fullscreen and Windowed options enabl
select which of your computer displays the
Resolume output should go to.

For a straightforward single screen setup, Fullscreen is usually the optio
fill the complete window with its output.

Windowed output just fills the second output with a rectangle exactly the
This is sometimes useful if you are using an external scan converter or a
applications.

You can stop all output by selecting the Disabled option.

Tipllf you accidentally went fullscreen on the main window, you won't be
controls anymore. Don't worry! Just hit CTRL-SHIFT-D (CMD-SHIFT-D on
get the interface back.

Advanced...

Hidden away in this tiny menru c¢pticns is

Composition output sharing

Texture sharing (Syphon or Spout)

This will enable sending your main composition output via the Syphon fra
Spout framework on PC.

Essentially, this will let you share the image created in Resolume to ano
processing.



Read more about

Network streaming (NewTek NDI)

This will enable sending your main composition output via the NewTek NI
computers on the same network.

ldentify Displays
This will overlay your outputs with a numbered and coloured image. The
numbers your computer has assigned to those monitors.

3-1-2-8-9-11-10-5-6-7-4? Yes, | know those numbers don't match the ord:e
No matter which order | plug the cables, Windows seems to assign these
proves how much we need a feature like this.

Open System Display Preferences

A quick shortcut to get to your computer's display settings. You know, fo
above somehow turned out wrong.

Show FPS

This will show a little FPS counter in the top left of the Output Monitor.
far you're pushing Resolume.

TipHigher numbers are better. If this consistently drops below 30, it mea
hard.

Bonus TNp!mbers higher than the refresh rate of your monitor are bad. It



and you're making your computer do more work than it's actually able to

Show Test Card

Shows a handy little test card with color bars, the current resolution and

diagonal line.

Show Display Info

This will overlay each connected display with EDID information, which GF
which GPU is currently being used for rendering.

TipDon't worry if the GPU listed under 'Gfx Card' is not the most powerfu
just tells you which card you are physically plugged in to. The GPU liste
and this should be your most powerful card.



Snapshot

This will save a .PNG still image of your output to your Recordings folde
current composition.



Advanced OQutput

Using Resolume's Advanced Output, you can manage all sorts of outputs.
outputs like a VGA cable connected to a projector, a DVI cable to a LED
Blackmagic Intensity, a DMX signal sent to a pixel strip, or even virtual

Multiple Outputs
If you are spanning your output over several projectors, or using a mix o
screens, projector and pixel strips, Resolume provides a flexible way to

time.

Using the Advanced Output, you can choose which outputs you want to us
to use them by setting up which parts of your composition are sent to wh
can send VJ content to the main area, while displaying a single line-up s

hall.

Projection Mapping

If you are doing a projection mapping show, you will use the Advanced O
projected content to the physical object you are projecting on. When usir
scale and resize your output to exactly fit the needs of the processor. If
controlled lights, you can choose which fixtures you need to send to.



Basically, the Advanced Output is where the magic happens.

Getting Started

The Advanced Output is available on both Avenue and Arena. To get ever
will need Arena.

For a quick start on how to use the Advanced Output with LED screens ot
check this chapter on creating input maps:

If you want to know the nitty gritty of all the features of the Advanced Ol
in the following chapters:

Saving and sharing Presets

It's possible to switch between different scre
Using the dropdown in the top left of the Adv
window, you can save and select different sef

This is especially useful when you are playing weekly gigs at different ve
specific setup. Using the preset system, you can just select the appropri
without having to recreate it again.

This also means that your output setup is not tied to a certain compositi
setups with the same composition, and use different compositions with th

It also allows you to share presets between computers. After saving, the



.xml file in the Resolume documents folder:
Mac: Users/~/Documents/Resolume Avenue-Arena 5/presets/screensetup/
PC: C:\Users\[username]\My Documents\Resolume Avenue-Arena 5\preset

TipBrowsing is for suckers. Choose Reveal in Finder or Explorer from the
taken right to the correct file on your computer.

You can copy this file to the same folder on the other computer. You can
the dropdown. When loading a preset via the dropdown, it will be automa
correct preset location.

Tip!'Sharing presets also works between Mac and PC!



Screens

To start using the Advanced Output, select the Output > Advanced menu
You will see a window that lists the active screens on your computer dow
Each screen represents an output going out of Resolume.

To setup a screen, right click on it on the left
will see a dropdown of all outputs that are con
your computer.

You can choose which output this screen should use. This way you can v
correct screen to the correct output when working with multiple outputs.

The screen will show the output it's sending to under its name, as well a
menu on the right. You can also change the name of a screen by double ¢

Types of Outputs

Connected Outputs

Any monitors or projectors connected to your computer are automatically
screens. Resolume will show the name and resolution of this connection.

Keep in mind! Resolume itself does not create outputs. This is handled b
have a screen connected to your computer, but it doesn't appear here, yc
sure your computer recognises it correctly. Check if it's set to proper ex
and the arrangement is not set to mirrored (Mac). You can read all about
displays in the chapiar on

Every output can only have a single screen associated with it. The poor |
get very confused when you try to send it two whole frames of pixels on
select an output already in use by another screen, Resolume will set the
back to virtual.

Tipllf you accidentally select the main monitor as your output, the output
you won't be able to access the interface anymore. Don't worry! Just hit



Mac ) to disable all outputs and get the interface back.
Playback Cards

Any connected cards that support playback will s
well.

Depending on the card, this will display various extra options that will le
which port and what video format to use.

TipFor fluent playback, choose a Video Format where the update frequen
fps, your composition's fps and your display's refresh rate. Outputting at
when your monitor is refreshing at 60Hz, your content is 30 fps and your
fps. Even when you're in Europe.

Also cards that have both an input and an output can be used for output.
cards support full duplex. Full duplex is a fancy word for simultaneous ir

Output via playback cards is only available in Resolume Arena. It has su
Blackmagic, Datapath and AJA products.



Syphon/ Spout

SyphofMac) afiglou{(PC) are protocols for texture sharing between applicat
the output of one application magically appear as an input in another apy
same computer.

Check out the chapter in the manual for more info on Syphon and S
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a
screen to output either via Spout or Syhpon, any Spout or Syhpon enable
Resolume as a sender.

Resolume will use the name you give the screen as the Server Name / Se
would be 'Screen 1'. You can change it to whatever you like. | would go \
screen has one speed: Go!

Resolume will use either "Avenue' or '"Arena’' as the application name.

You can change the width and height of the screen to change the resolut
to share.

NewTek NDI

Similar to Syphon/Spout, NewTek NDI will let your share your output with
support the NDI protocol. The added advantage is that NDI works with mt
connected to the same network.

You can use this to send a single output from VJ laptop to a master serv
to scale and position the output to the pixelmap.

When enabling NDI output, Resolume automatically announces itself on t!
enabled applications will pick it up automatically.

Virtual Outputs

Virtual Outputs are sort of an internal Syphon/Spout, just for Resolume.
outputs can be picked as input for slices in other screens.

This allows all sorts of complex scaling and routing possibilities, with a

You can change the output resolution of a Virtual Output by changing its



Adjustments

Adjusting Output Levels and Color

Each screen has Opacity, Brightness and Contrast
as individual controls for the Red, Green and Blue
can use these to adjust mismatched outputs. For il
can dim the brightness on a LED panel while sendi
undimmed output to a projector as well. Or you ca
red from a projector when it doesn't match the oth
you are using.

Adjusting Delay

Each screen can have a delay between 0 and 100 ms, to account for smal
signal chain after the outputs leave Resolume.

Hiding and Folding Screens

You can temporarily turn a screen off and on by clicking the toggle in fro
disable all output to that screen. This is very useful when identifying wh
troubleshooting or to temporarily disable a single screen during performa

You can also fold and unfold a screen by clicking the arrow beneath it. T
going, while hiding all the slices contained in the screen. This is useful
in the way when working with lots of screens and slices.

Preparing before show

You can prepare your screens without having them physically connected.
need to prepare for a show before the venue is open.

When you open the Advanced Output without having any secondary scree|
with a single Virtual Screen. You can set the resolution of this Virtual Sc
Height parameters on the right hand side.

By matching these settings to the resolution that your output will have di
prepare your setup beforehand. Then, once you are connected to the actt
your screen to use that output instead, via the right-click dropdown.

You can create as many Virtual Screens as you need via the Plus+ menu.



Input Selection

After setting up your outputs correctly, you can control how your content
outputs using the Input Selection.

The Input Selection stage shows a preview of your composition output.

On the left hand, it shows all active screens. You can read more about s

Slices



Each screen can have one or more slices. To ge
around Input Selection and slices, think of your
as the pie and your slices as, well, slices of th;:
defining a slice, you can control what output wi
parts of your pie.

For instance, you can define that the left hand side of the composition w
on output 1, and the right hand side should go to the projector on output
to dividing it vertically, or even halfway. You can select any part of the ¢
account for different output resolutions and aspect ratios.

You are not limited to a single slice per screen. You can create as many
plus+ menu. The sky is the limit.

Ummm. Actually. There is a limit. You can't create more than 115292150/
your computer will run out of resources far before that, but on a compute
processing power, you could create one slice every second for the comin
151 million slices for each person living on Earth right now. Or if you go
could buy Star Wars back from Disney, 2.5 million times.

Resizing, Moving and Rotating



When you open the Advanced Output, it always has one screen with one s

You select this slice by clicking it on the left hand side. You can then re
the Input Selection stage.

You can scale, position or rotate the slice simply by dragging. Rotating t
working with rotated LED panels.

Tip!Slices will snap to the stage edges, the center and to each other. Yol
snapping by holding down CTRL.

You can also type precise numbers into the boxes at the right. This is us
to show a precise part of the composition.

TiplYou can use math to let Resolume do calculations for you. Verrrry hal
a slice exactly a third of its width, all you need to do is type /3 after tf

Also you can nudge slices 1 pixel at a time by using the arrow keys. Holc
the keys to nudge them 10 pixels at a time.

Right clicking a slice, either in the list or on the stage, will reveal a dro
presets and actions. Check the complete list an the

TiplOne interesting option is Match Output Shape. This will let the slice t
it has on the Output Transformation stage. This way you can quickly mat«
positioning for pixel perfect pixelmaps.

You can create as many slices as you like. You can duplicate an existing
plus+ menu.

Also you can move slices between screens. Simply drag and drop them to



that a screen should always contain at least one slice, so Resolume will
drag the last slice to another screen.

Slice Masks

Slice masks are available on Resolume Arena only!

Slice masks can be used to further narrow down the shape of your slice.
slice is limited to a rectangular shape. By using slice masks, you can de
rectangle you want to see in your output.

To create a slice mask, click on any of the preset options on the right ha
Selection screen. You can also click on the pencil to create a completely
invert a mask to make it a crop and vice versa. By toggling the Invert bu
you can either show everything inside the mask, or everything outside it.

After you have created the mask, you will notice two options in the top ri
stage: Transform and Edit Points.

Transform

In Transform mode, you can move the slice mask around like a regular sl
options for scaling, positioning and rotating.

Be careful not to move the slice mask completely out of the slice, becaus
output. We know less is more, but that's maybe a bit too minimal.



TipMWhen using a mask to create a specific shape for mapping, it helps tc
scale as the shape you intend to use. As opposed to cutting out a small |
still warp the slice based on the corner points of the slice, not the corne

Edit Points

In Edit Points mode, you can edit the individual points of the slice mask.
around by dragging or nudging them into position with the arrow keys. Yc
shape by double clicking anywhere on its path. Double click on an existir

Here you can also switch the mask between linear and bezier. Linear dra
between the points, bezier lets you draw nicely curved lines. In bezier m
be round. Each point will get two bezier handles, that you can use to cur

Polygon Slices

Polygon slices are available on Resolume Arena only!

If you want the ultimate control over the shape of your slice, poly slices
slices will give you complete freedom on the shape and control points of
hexagons, stars or complete freeform, it's all possible with a poly slice.
You create a poly slice via the plus+ menu. You can either create a pres
freehand polygon by drawing it on the stage.

When drawing a poly slice directly on the stage, start by clicking where



control point to be. Now keep clicking around your shape, placing a conti
When you're done, just click on the start point or double click anywhere |

Once you have created your poly slice, Resolume will triangulate it for y
that you have set in the Input Selection stage will be available in the Ou
as well.

Keep in mind that it's possible to create a shape that's not 'triangulatabl
shape that crosses its own path. In cases like this, Resolume will draw t
let you know what you're trying to do is mathematically impossible in thic
same reason, bezier points are not available on poly slices.

Transform Mode

After you have created your poly slice, you can still modify its scale, rot
Transform mode. In this mode, the poly slice behaves like a regular slice

Edit Points Mode

In Edit Points mode, you can still add and remove individual points as we
In this mode, the poly slice behaves like a mask.

Multi Select



You can move, scale and rotate multiple slices at the same time.
Drag around a group of slices on the stage to lasso them together. You ¢
slices, either in the list or directly on the stage to add or remove them fi

A bounding box will appear around your selection that you can drag, rota
Also the properties on the right hand side are still available on the right
input. Keep in mind that the numbers reflect the properties of the boundi
slices!



OQutput Transformation

The Output Transformation stage is available on Resolume Arena only!

The Output Transformation stage is where all the magic happens. You us
projection mapping structures or shuffle your pixels for output to a LED

Transforming

The same screens and slices you've configured on the Input Selection st
Output Transformation stage.

Just like on the Input Selection stage, on the Outpu
stage you can change the size and position of your
done in the Transform tab. In this tab, you change
scale of your entire slice. The difference is that no
move the pixels around, as opposed to choosing a different set of pixels

This way, you can for instance take the bottom left quarter of your comp«
the top left of your output.

Warping



Additionally, on the Output Transformation stage yo

screen warping, which means you can adjust the ge

final output. This is useful for projection mapping t

irregularly shaped surface, or when aligning multipl
a spanned output.

This warping is done in the Edit Points tab. In this tab, you can adjust tf
make up your slice.

There are several ways to warp.

Perspective Warping

You apply perspective warping by changing the four large corner points c

Perspective warping keeps the perspective of your output correct. For in:
an angle, the light hitting the furthest point of your surface will disperse
hitting the closest point. This means that your content will get more and
along your object it is. Using perspective warping, Resolume adjusts for
your content correct along the length of your object.



Linear warping (left image) vs perspective warping (right image) when pr
degree angle. Notice how the grid squares are evenly spaced on the righ
the left.

For most simple cube mapping work, perspective warping is the mode you

Perspective warping is available on regular slices only. Poly slices cannt
Because of science.

Linear and Bezier Warping

Linear warping is applied by the four smaller corner points inside the pei

These points work the same way as their bigger bro
they do not adjust for perspective. They have the ai
that you can add more points horizontally and verti
complex warping.



Also you can switch the mode from Linear to Bezier
then show two additional bezier handles that you ca
the warping curve like a Coca-Cola bottle.



TipWhy choose when you can have both? Use the big corner points for pe
baby brothers for additional bezier warping. This way you can have nice
maintaining correct perspective.

Linear warping is also available on poly slices. Poly slices are super awe
change the position of each point of the mesh. Bezier warping is not ava
Because of science.



Masking

In the Output Transformation stage, you can also add masks. Masks allov
output, without distorting it. You can add as many masks as needed.

A mask will cut off all pixels that are outside of it. You can invert a mas!

TipNerd alert! The way we are most used to masking from for instance Af
After Effects, masks are actually crops, since they cut off the outside of
mask in Resolume is inverted. This way you get the behaviour you're use
over the fact that it's actually technically incorrect terminology. Because
us up at night.



Masks and crops can have an arbitrary amount of points. By default you «
of commonly used preset shapes, but you can make them into stars, the |
the shape of that weird stain on the wall in your attic.

Double click the outline to add a point at that locat
a point to remove it. You can make round corners b
Point Mode to Bezier.

Note that masks are applied to all the slices underneath it.

Slice Options

On the Output Transformation side, slices have some additional options.
Flips

Using the Pacman icons, you can flip a slice's outp!
vertically or both.



This way you can very easily make a mirrored setup by duplicating a slic
to mirror it across the x-axis and then flipping it using the Pacman icon.

Color Correction

Each slice can have its brightness, contrast and rec
channels adjusted. You can also multiselect slices
of them at the same time.

This way you can adjust for differences between projectors when using a
to adjust the brightness levels for different LED panels connected on the

Is Key

Toggling Is Key will cause this slice to replace the
luminance. It will send out white wherever there are
and black where there is transparency.

This is useful to send an alpha channel on a separate output for overlayi
broadcast mixer.

Black BG

Black BG is not a racially themed 70s cover band. T
render your slice with a black background, regardle
content is playing in it.

This is useful when you have a slice partially covering another slice, anc
reveal the parts of the slice underneath.



DMX Output

DMX Output is only available on Resolume Arena!

Resolume Arena can output the color or brightness of your pixels to LED
fixtures via DMX.

This means you can play your videos on low resolution LED strips or othe
input. Make it part of your stage design and take charge of the lights as

Using DMX Lumiverses

To do anything with DMX Fixures, first you will neef
Lumiverse.

A DMX Lumiverse is basically a DMX universe, except it only exists virtu
regular DMX universe, it consists of 512 channels. You use a Lumiverse |



fixtures.

This way, you can prepare your pixel map at home. When it's showtime, Yy
a whole Lumiverse to the actual Art-Net node. Also, you can quickly char
nodes, without having to rebuild your pixel map from scratch.

TipLumiverses are not a common DMX term. They're just used within Res
Don't use the word Lumiverse when talking to your LD buddy. He'll think
baccy.

You create a Lumiverse simply by adding one via the + menu.

A Lumiverse has the same Opacity, Brightness, Con
options that a regulahas. They behave the same way

In addition, it has a Framerate and Delay setting.

Framerate

The framerate determines how often (per second) you send out the Lumiv
Higher values make fixtures more responsive but are more performance il

more data per second down the cable.

Delay

The delay determines the time between rendering the frame and outputtin
milliseconds). This is used to keep lights/projectors in sync.

The default value of 40ms will give a good result when matching lights al

When using Resolume to control pixelstrips or lights only, you can chang
immediate output without delay.

Using DMX Fixtures

When you first create a DMX Lumiverse, it will create one default DMX fi
fixture contains 1 pixel of RGB data.

Unless you're controlling the sun via DMX, it's quite likely you'll need to
fixture than a single RGB pixel. You can select a different fixture preset
using the drop down on the right hand side.

TiplIlf your fixture is not in the list, don't worry. You can very easily and



presets. You'll probably want to reapatgee first.

Let's say that you have a set of three LED tubes. Each tube has 16 RGB
in a triangular shape on the centre of the stage.

Select the Fixture

The first thing to do is to change the default fixture to the corresponding

You'll notice that the fixture name has changed. Also the Input Selection
become 16 times as wide. This is because you can now assign colours fo
1.

Position the Fixture

You can move, scale and rotate the input of this fixture to match the phy
your stage design. Let's make it 800x50 pixels. Assign its input to the bc
composition by placing it in the bottom centre of the Input Selection win
the very centre pixel of each square as input for the RGB channel. You'll
it s sending in the preview on the bottom of the slice info.

Tip!lOf course changing the input size in pixels doesn't change the size o
in the composition doesn't change anything to its physical location. But i
match the input size and position of your other stage elements, such as |
tiles. This will create a matching picture on all your screens and lights w
them.

More Fixtures!

Create another DMX fixture via the big + drop down menu. You Il notice t
a 16 pixel LED bar. Resolume will take the previously used fixture as the
DMX fixtures.

Make this fixture the same width and height as the previous one, but rote
it so that it makes the left leg of a perpendicular triangle.

Create the third fixture by duplicating the second fixture. You do this by
either in the list on the left or in the Input Selection canvas itself. Rotat
to finish off the triangle.

TipUse the scroll wheel or CTRL + and - ( CMD + and - on a Mac ) to zoc
fixture slice. You can use the pan tool or hold down spacebar to pan the



Sending DMX to your LED lights

After setting up all your inputs, it's time to actually send out some outpu

Right-click on your DMX Lumiverse. Just [
Screens, Resolume will show a list of the
Net nodes on your network.

Simply select the name of the node you want to use and Resolume will fil
like IP addresses and universes for you.

Tipllf your device doesn't show up in the list, make sure the IP of the de\
Resolume are in the same IP range and are using the same subnet mask.

Picking the right Network Interface

It could be that your computer has both a wired and wireless network inte
nodes are on your wired network, but Resolume is looking on the wifi, it



anything.

You can make sure Resolume is looking on the right network via the DMX

Using a manual IP

It could be that you're using some sort of homebrew Art-Net device, like

In that case, it probably won't show up in the node list, but you will still
On the right hand side, choose IP Address from the Target IP dropdown.
manually.

Remember that in this case, you will need to set the Universe and Subne
most devices, Universe 0 on Subnet 0 is the default setting for the first |

When sending Art-Net to a specific named node, Resolume will remember
keep sending to it, even if its IP address changes. When sending to a sp
will keep sending to that IP, even if the device changes or if there's nott

Using Broadcast

Instead of sending to a specific node, you can also broadcast DMX to all
network.

If sending to a single node is like addressing a request to a person by n:
take out the trash please?"), broadcasting is the same as shouting really
someone will listen ("SOMEONE NEEDS TO TAKE OUT THE TRASH! LIKE,

When broadcasting, there is no need to set the IP, but you will need to s
Universe accordingly.

When you start hitting 30 universes or more, it's a good idea to stop usir
gigabit switches and unicast instead.

A word on DMX USB devices

Resolume Arena 6 does not support Enttec DMX USB devices. If you'd lik
DMX USB device, your only option is to stick with Arena 5.

Because USB boxes are limited to one or two universes, Resolume only s
solution. and several other companies have boxes to get up to 8 or
of DMX over a single Art-Net connection. If you're not afraid of some DIY



Patching your Lumiverse

Switch back to the Screen Setup, select your Lumiverse and switch over

DMX Output is the overview of how your fixtures are arranged in your Lul
first fixture takes up 48 channels. This makes sense, as it has 16 pixels,
(16 * 3 =48 1).

The second fixture starts at channel 49, right after the first one finishes
97. These Start Channels should correspond to how your dip switches are
tubes. This way Resolume knows which set of pixels need to be sent to w

TipYou know there's 10 kinds of people in the worl
that can't count in binary, you can see how your d|
be set up visually in the bottom of the fixture info

If your LED tubes are set up differently, you can simply drag the fixtures
window. You Il notice the Start Channel and the dip switches update then
prefer, you can adjust your dip switches directly or just type in the Start
then arrange themselves in your Lumiverse. Just make sure the channels
you might get weird results. Resolume will warn you when this happens, |
overlapping channels with red.



After you have set up the correct start addresses, your LED tubes should
playing on them. If one or more tubes were placed upside down or the wr
use the Pacman icons to flip their output. Also you can adjust their brigh
that be necessary.

Aligning your output

To check whether your outputs line up correctly, you can use the Test Casa

The test card has a diagonal line moving across the screen, so you Il qui
are somehow placed different in the physical world, than how you placed
Selection tab.

If something is wrong, first make sure the Start Channels match up using
it might be necessary to use Pacman to flip the output horizontally and/o
to the fixture.



Parameters

Everything in Resolume is controlled by parameters. Parameters come in
sizes.

Sliders

First and foremost we have sliders. Sliders enable us to set something tc

For instance, the Scale of a clip is a slider. To use a slider, click in the
left or right. If you want to set a parameter to a specific value, click the
new value and hit return.

TipMWhen dragging a slider, Dingetje will pop ur
Dutch for "Thingy" and Dingetje is useful to qui
numerical value. You can also click on the left
onDingettje increment and decrement the value b
amount.

YedDingetjereally how we refer to this Ul element, both in the office as w

You can also do math when typing values. So for instance, if you want to
to exactly one third of 1920, simply type "1920 / 3" and Resolume will do

If you knew it was 640 without getting a calculator out, you've been a VJ

Some sliders are compound sliders, which means that they expand to rev
instance the Rotation slider, which by default rotates the image around i
reveal Rotation X, Y and Z, for full rotation across all axes in 3D space.

You can set a slider back to its default value, simply right clicking on th

Toggle Buttons



Toggles can be used to turn something on or off. The big B and S button:
They both control the visibility of the layer. B is Bypass or Blind, and tu
and turns all other layers off.

Every effect also has it's own bypass toggle.

You will also see toggles as little boxes that can be ticked. For instance
for Horizontal and Vertical, which control which axes the image is flippec

Event Buttons

Events are buttons that trigger a certain action.

The big X on the far left of each layer is an event button. When you click
playing clip from that layer. After that, it goes back to being a pretty litt
it again.



Occasionally, you will come across an event button in an effect as well.
effect has an event called Randomize, which randomly re-arranges how tl
across the cube.

When you get right down to it, clip triggers are also sort of event button:
Hmmm. This makes my head hurt.

Radio Buttons

Some buttons are grouped together. These are called "Radio Buttons".

A group of radio buttons can only have one button active at a time. When
options, the others will automatically be deselected.

This is how radios worked in, like, the 1940s, so that's why we still call
we're old.

A good example are the playhead controls for a clip, which let you set if
backward, is paused, or jumps to random frames.

Another example is the Autopilot for every layer.

Dropdowns

Dropdowns will reveal a list of possible choices and let you pick the one

The Blend on each layer is a dropdown with a huge list of choices. Like,






Also, a clip can be switched to a number of different playback modes via

Color

Color is a very important aspect of visual performance. Maybe the most i

Resolume gives you fine grained control over color. Wherever color is us
special Ul item to set it.

The default view is acetanddctk&Srimply move your mouse to pick the exact
feels right to you.

If you're more of a number person, you can also R6&tBdhHeS Bhledeoborl o stimags e
mode, you can get the color you want by entering the exact Red, Green a
Saturation and Brightness values. Using sliders gives you the added adv:
animation, and an extra slider for the alpha value.

Palette

A Color parameter also has the option to show a Palette. On a Palette, vy
favorite colors.



If you want to add a color to the Palette, simply drag it from its preview
Palette. By right-clicking on a swatch, you get more options to remove a
swatches, or update the swatch with the current color.

Control

Parameters can be automated in a number of ways. You can read all abol



Parameter Animation

You have seen how a wide variety of things can be controlled in Resolum
sliders, from the volume of the composition to an individual setting on ar

The good news is you don't need to give yourself an repetitive strain injt
you can set parameters to animate by themselves.

To access these options, click the little grey triangle ne:
name. A menu will appear.

The options in the menu will be slightly different depending on whether t
working with is for a clip, a layer, a group or the composition. However,
same way.

The and get the super special treatment and have their own

Timeline

Thelimelineption presents you with an interface similar to the Timeline cl
can have the parameter loop, ping-pong, random or play once and you ca
parameter animates at.

You can also set in and out points for the parameter, just like with a

Tip After setting in and out points, hold down Shift while dragging the ra
range around, while keeping the length the same

BPM Sync



SimilaBPM Syng like the BPM Sync transport mode on the clips.

You set the number of beats that the parameter should animate over, whe
ping-pong and the in and out points. The parameter will then be animatec
BPM.

Clip Position
This option is available on clips only.

It lets you sync a parameter to the playhead of the clip. The parameter w
the clip. You can scrub, skip, change speed, change direction or even be
parameter will follow everything.

Audio Analysis

Audio analysis enables you to drive parameters directly f
make your visuals dance.

If you are really brave you could also use Audio Analysis to drive audio |
what would happen?

To activate audio analysis, select one of the FFT options in the control o

parameter:

External FFT

Use the audio device specified in the audio preferences to drive the para
use if you want to use a feed from a DJ or band or if you have an externz

You have to select a source if you want to use the external option. This
First choose which Audio Input device you want to use,
channel from the list of its available channels.



Composition FFT
Use the main audio output of the composition to drive the parameter.

Clip/Layer/Group FFT

Use the audio output of the clip, layer or group to drive the parameter.

The parameter display will now change to display the Audio Analysis opti
should do is click the small grey arrow to display the full options.

You can now ukeMthedd buttons to select the Low, Middle or High end freq
to drive the parameter. You can take even finer control of the frequencie
and out points below the audio spectrum display.

Use tiGeaincontrol to boost the signal until it is having the right amount of
parameter. FlddlEeontrol sets how quickly the value falls back from a peak.

TipThere's also a master gain in the audio tab of the preferences as well
it via View > Show Audio Gain, and it becomes visible on the center tooll

The buttons on the left enable us to drive the parameter directly from lov
or to have the audio signal drive the speed the parameter moves at in eif



Keyboard Shortcuts

Controlling Resolume with the mouse is great. You can access every parz
precision. But during a live performance, you'll want to have more contro
offer. Sometimes, you want an exact thing to happen at an exact moment
and search for it with the mouse. That's where shortcuts come in.

You use shortcuts to assign a button on your computer keyboard or MIDI
Resolume. Sort of like how CTRL-C and CTRL-V are shortcuts for copy-pe
get to decide what the shortcuts are.

Resolume supports external control via your computer keyboard, MIDI col
messages. If you're running Arena, you can also use DMX input from a li¢

Assigning Keyboard Shortcuts

Let's start with a simple keyboard shortcut. We want the spacebar to be |
we press spacebar, the whole output should go black. This is useful as a
no, get it off mah screen!"), or to create tension before a big drop.

You create shortcuts by opening the Shortcuts menu,
which protocol you want to create a shortcut for. So
Edit Keyboard. The interface will now turn partially b

You can also use CTRL-SHIFT-K as a shortcut to enter Shortcut mode. St

Toggle

Everything blue can have a shortcut assigned to it. So find
Bypass button in the top left of the interface and click on it
press the spacebar, and voila, you've assigned your first sh
button was big enough, you could even read it had the spac

Press the Escape key to exit the Shortcut mode, and you can now bash tt
Composition Bypass on and off. On and off. On and off. On and off. Okay

Piano mode

Let's dig a little deeper. Go back into Keyboard Shortcut mode, and sele
again. In the bottom right of the interface, you'll see the Shortcuts tab.
you're in Shortcuts mode. In this tab, you can see all your keyboard shor

You can also choose different options for your selected control.



The Composition Bypass is a very bas
it can either be on or off. Still, it has
namely "Piano". All buttons in Resolu
set to Piano mode, which means that -
be on for as long as you hold the key
and turn off when you release the key

"But Resolume, that's not how a piano works at all!"™ Yes, you're right. Pi
reminds you that you're playing an instrument. If you prefer, you can cal
or whatever floats your boat.

Once you enable Piano mode for a shortcut, you also get t
This will let you turn the control OFF while the button is h
released.

Range

You can get even further down the rabbit hole when you assignh a button
parameter. Let's first set up a fun parameter to play with.

Put the Invert RGB effect on a clip. Leave all its parameters alone, but j
Mode to TimeSwitcher. You can now strobe the inverted clip, using the O
control the rate. Pretty cool, right?

Now go into Shortcuts mode, and assign a shortcut to the Opacity of the
with the ']'" key.

You will see new options appear in the Shortcuts tab. The biggest one is
You're now assigning a button shortcut to a slider, and a slider has more
off. With the Range option, you can see what values the slider should jur
pressed and released.



Let's set the values to 0 and 0.10. You can either drag the in and out po
the values and enter them numerically. After you exit Shortcut mode, you
strobe the clip with 10% opacity and off again. Braaaaap!

In this mode, you also have the Piano option. Br-Br-Braaaap!

Value

Instead of just toggling, a button can also be used to
directly to a specific value. In the shortcuts panel, vy
Mode from Toggle to Value. Don't worry, we'll cover |
patient, young grasshopper.

In Value mode, you can use the keyboard to set a slider to a specific val
Opacity of the Invert RGB to 0.10, regardless of what it was set to befor
a parameter to a certain value.

Multiple Shortcuts

Multiple shortcuts are especially awesome! You can assign more than ont
Simply select the shortcut, right click it and select 'Duplicate Shortcut"'.

You will see that ] is now used twice as a shortcut for rotation. By clicki
selected and you can change it to whatever you like, just by pressing a o«

Let's go with [ and ] as the two keys.

Now each shortcut key can have different settings.



Let's set both keys to Toggle Mode, with Piano turned on. Set the range
and 0.05. Set the range of the second shortcut to 0 and 0.1. Now you cat
different rates. Because they're set to Piano and the minimum range for |
releasing any button will always turn the effect off.

Tiplf you're not that big on blinding your audience with epileptic strobing
as using multiple keys to set the Hue of a Colorize effect to specific vall
match the color of the video to the color of the lights.

Shortcut Target

When you assign shortcuts to clip triggers or controls on the layer, clip ¢
this target option. The Target option lets Resolume know exactly how yolt
shortcut. There are three modes:

By Position

This target just applies the shortcut to whatever orde
layers are in. This is the default mode for shortcuts ¢
group panels.

For instance, shortcuts for Layer Opacity default to By Position. Because
your first fader on your MIDI controller to control the first layer in your «
how you re-order the layers afterwards.

This Clip, Layer or Group

This target applies the shortcut to this specific clip,
regardless of where you move it.

This way, you can assign a shortcut to always trigger a specific clip, like
matter whether that clip is in layer 1, column 1 or layer 27, column 95. I1
that specific shortcut.

Beware! When you delete that specific clip, layer or group, of course the



Selected Clip, Layer or Group

This target applies the shortcut to whatever clip, lay¢
currently selected. This will always be the clip, layer
currently shown in its respective panel. This is the d
any shortcuts you apply on the clip panel.

Wait? What?

"Come on, Resolume! Why you gotta make this so difficult? | just want to
it. Ain't nobody got time for this! Just tell me what to do already!"

If you're unsure about what any of this means, just go with the 'By Positi
shortcuts. It makes the most sense when working with a fixed controller |

The 'Selected' target is very powerful to optimise controller real estate,
what you're doing.

The 'This' target is usually only necessary to control a very specific thin
only.

Shortcut Groups

Shortcuts Groups are shortcuts applied to a group of Radio Buttons, or t«
what Radio Buttons and Dropdowns are exactly? They're explained in det

Shortcuts assigned to these type of control are special. A r
has only two options, On or Off. Shortcut Groups have a lot

The Clip Direction controls have four options, Forward, Backward, Pause
Autopilot has four also. The Layer Blend Modes have so many options | |

When assigning shortcuts for these controls, you enter a whole new level
where you go from someone who mashes buttons to a distinguished short

Direct

The most basic one is assigning a shortcut directly to a particular 'item".
perhaps. It simply means you could for instance assign one key to play tl
another key to play the clip backwards.



You do this simply by selecting the buttons in the interface, and assignir
see which state you have assigned in the Mode box.

The same way, you could also assign shortcuts for each Layer Blend Mod
Auto Size options on the layer.

Piano

Piano is also available as an option when you assign a shortcut directly
toggled on, pressing the shortcut will switch to that item, and releasing |
whatever is was set to.

This way, you can quickly set the clip to random playback during an espe
music, and then release the button to go back to whatever direction it wa

Next/Previous/Random

It get a bit crazier by using the Select Next Item, Select Previous Item a
selecting these, you can cycle through every item in that group of contro

This way, you can for instance cycle through all the layer Blend Modes. °
the same button until you land on one you like.

Cycling Specific Items

If you really want to get to the nitty gritty of shortcut control, try duplice
assigning it to a different item in a group.

For instance, assigning the same key to both play forwards and play bacl
between these options with one button. Back and forth. Back and forth. B
want to go full control ninja, you can even use Piano in combination with

You can assign as many items to the same key as you like. Resolume wil
item on every key press.

Keyboard Specific Modes

There is one specific mode that is only available for keyboard shortcuts.
know that sounds weird, but it's pretty awesome.

Mouse Mode

In Mouse mode, you can use the mouse to control a parameter while you



pressed.

For instance, you can assign the P key to a clip's Position X. Switch to N
range to -960 and 960, or whatever your composition size is.

When you now press the P key, horizontal mouse movements control the |
| bet you know where this is going now, right?

Assign the P key to Position Y also. Switch to Mouse mode, but now swit
to -540 and 540, assuming you have a 1920x1080 comp.

Now holding the P key will give you full control of the clip's position. Re
the clip where it is and let you use the mouse for pointing and clicking a

Shortcut Presets

You can save presets for every shortcut mode. This allows you to save a
and shortcut assignment for different occasions.

For instance, if you're a gear head, you can have different presets for ec
normal person could have have different layouts for the same controller,
styles of shows with it. Or you could have a separate preset for that one
musician buddy. The sky is pretty much the limit.

Every shortcut you assign is automatically saved into the current preset.
the dropdown in the Shortcuts panel. Here you can also mbheaqge. \Soamepre
as.../RemodRenameptions at the bottom of the list.

Presets are simply XML files stored on your computer. So you can exchar
computers, or share them with your VJ friends. Or share them with other
forum.

Once selected, you will see a list of all assigned shortcuts for this prese



This list contains each and every shortcut you currently have assigned, ¢
troubleshoot things. If you're a bit of a nerd, you can probably already s
controlling, just by looking at its name.

By default, the list is organised per shortcut name. You can also sort it j
really easy to spot double assigned shortcuts. These will be marked in re



You can delete a unwanted shortcut by hitting backspace or selecting De
menu. Bad shortcut. Bad.

Default

Resolume ships with a default shortcuts layout that we think is kind of u:
to modify it how you see fit, or completely ignore it. Resolume is freedon

Peep the shortcuytyo.



MIDI Shortcuts

Controlling Resolume with the mouse is great. You can access every parz
precision. But during a live performance, you'll want to have more contro
offer. Sometimes, you want an exact thing to happen at an exact moment
and search for it with the mouse. That's where shortcuts come in.

You use shortcuts to assign a button on your computer keyboard or MIDI
Resolume. Sort of like how CTRL-C and CTRL-V are shortcuts for copy-pe
get to decide what the shortcuts are.

Resolume supports external control via your computer keyboard, MIDI col
messages. If you're running Arena, you can also use DMX input from a li¢

In this chapter, we'll show you how to control Resolume with a MIDI cont

Assigning MIDI Shortcuts

You can assign shortcuts for your MIDI controller in exactly the same wa

The only difference is you need to let Resolume kno
MIDI controller connected first. You do this via the
Preferences.

For now, all you need to do here is toggle on MIDI Input and MIDI Qutput
use. That's it. We'll worry about

TipNot sure if your MIDI controller is working or not? Fold out the MIDI 1
Preferences. Resolume will show you all the MIDI messages it's receiving
you're seeing messages come in here, but Resolume is not doing anythin
with your shortcut setup. If nothing is showing up here, something is wro



Let's start with a simple shortcut. We want a shortcut for the blackout bu
shortcut, the whole output should go black. This is useful as a sort of pa
mah screen!"), or to create tension before a big drop.

You create shortcuts by opening the Shortcuts menu,
which protocol you want to create a shortcut for.

The interface will now change color. For MIDI shortcuts, we went with a |

Toggle
Everything that has changed color can have a shortcut assig
Composition Bypass button in the top left of the interface ar
mouse.

Now press the control you want to use for this. | suggest to use a button

controller. Ideally you can find it without looking down. Maybe something
controller?

Either way, press the button and voila, you've assigned your first shortct



big enough, you could even read which shortcut was assigned to it.

Press the Escape key to exit the Shortcut mode, and you can now bash y
Composition Bypass on and off. On and off. On and off. On and off. Okay

Piano mode

Let's dig a little deeper. Go back into Shortcut mode, and select the Col
the bottom right of the interface, you'll see the Shortcuts tab. This tab is
Shortcuts mode. In this tab, you can see all your shortcuts in a handy lis

You can also choose different options for your selected control.

You'll see a bunch of stuff about Channels, Notes and Midi Output. We c:

Right now, we're only interested in one option, namely "Piano". All buttol
to Piano mode, which means that they will be on for as long as you hold
and turn off when you release it again.

"But Resolume, that's not how a piano works at all!"™ Yes, you're right. Pi
reminds you that you're playing an instrument. If you prefer, you can call
or whatever floats your boat.

Once you enable Piano mode for a shortcut, you also get t
This will let you turn the control OFF while the button is h
released.

Nerd aleFtdr some arcane reason, some controllers (like the NanoKontrol)
Notes when you press a button. | won't bore you with the technical detail
makes no sense. If the shortcut for your button says CC instead of Note,
Invert options, just change the Mode to Button and you'll be golden.



Range

You can get even further down the rabbit hole when you assign a button
parameter. Let's first set up a fun parameter to play with.

Put the Invert RGB effect on a clip. Leave all its parameters alone, but j
Mode to TimeSwitcher. You can now strobe the inverted clip, using the O
control the rate. Pretty cool, right?

Now go into Shortcuts mode, and assign a shortcut to the Opacity of the
button on your controller that makes sense to you.

You will see new options appear in the Shortcuts tab. The biggest one is
You're now assigning a button shortcut to a slider, and a slider has more
off. With the Range option, you can see what values the slider should jur
pressed and released.

Let's set the values to 0 and 0.10. You can either drag the in and out po
the values and enter them numerically. After you exit Shortcut mode, you



strobe the clip with 10% opacity and off again. Braaaaap!

In this mode, you also have the Piano option. Br-Br-Braaaap!
Value

Instead of just toggling, a button can also be used t
directly to a specific value. In the shortcuts panel, \
Mode from Toggle to Value. Don't worry, we'll cover
Be patient, young grasshopper.

In Value mode, you can use your controller to set a slider to a specific v
will set the Opacity of the Invert RGB to 0.10, regardless of what it was
for resetting a parameter to a certain value.

Multiple Shortcuts

Multiple shortcuts are especially awesome! You can assignh more than one
Simply select the shortcut, right click it and select 'Duplicate Shortcut'.

You will see that your shortcut is now used twice. By clicking one of ther
you can change it to whatever you like, just by pressing a different butto

Now each shortcut key can have different settings.

Let's set both keys to Toggle Mode, with Piano turned on. Set the range
and 0.05. Set the range of the second shortcut to 0 and 0.1. Now you car
different rates. Because they're set to Piano and the minimum range for |
releasing any button will always turn the effect off.



Tiplf you're not that big on blinding your audience with epileptic strobing
as using multiple shortcuts to set the Hue of a Colorize effect to specific
match the color of the video to the color of the lights.

Shortcut Target

When you assign shortcuts to clip triggers or controls on the layer, clip «
this target option. The Target option lets Resolume know exactly how yolt
shortcut. There are three modes:

By Position

This target just applies the shortcut to whatever orde
layers are in. This is the default mode for shortcuts ¢
group panels.

For instance, shortcuts for Layer Opacity default to By Position. Because
your first fader on your MIDI controller to control the first layer in your
how you re-order the layers afterwards.

This Clip, Layer or Group

This target applies the shortcut to this specific clip,
regardless of where you move it.

This way, you can assign a shortcut to always trigger a specific clip, like
matter whether that clip is in layer 1, column 1 or layer 27, column 95. I1
that specific shortcut.

Beware! When you delete that specific clip, layer or group, of course the

Selected Clip, Layer or Group

This target applies the shortcut to whatever clip, lay«
currently selected. This will always be the clip, layer
currently shown in its respective panel. This is the d
any shortcuts you apply on the clip panel.



Wait? What?

"Come on, Resolume! Why you gotta make this so difficult? | just want to
it. Ain't nobody got time for this! Just tell me what to do already!"

If you're unsure about what any of this means, just go with the 'By Positi
shortcuts. It makes the most sense when working with a fixed controller |

The 'Selected’ target is very powerful to optimise controller real estate,
what you're doing.

The 'This' target is usually only necessary to control a very specific thin
only.

Shortcut Groups

Shortcut Groups are shortcuts applied to a group of Radio Buttons, or to
what Radio Buttons and Dropdowns are exactly? They're explained in det

Shortcuts assigned to these type of control are special. A regular contro
options, On or Off. These controls have a lot more.

The Clip Direction controls have four options, Forward, Backward, Pause
Autopilot has four also. The Layer Blend Modes have so many options | |

When assigning shortcuts for these controls, you enter a whole new level

where you go from someone who mashes buttons to a distinguished short

Direct

The most basic one is assigning a shortcut directly to a particular 'item".
perhaps. It simply means you could for instance assign one key to play tl
another key to play the clip backwards.

You do this simply by selecting the buttons in the interface, and assignir
see which state you have assigned in the Mode box.

The same way, you could also assign shortcuts for each Layer Blend Mod
Auto Size options on the layer.



Piano

Piano is also available as an option when you assign a shortcut directly
toggled on, pressing the shortcut will switch to that item, and releasing i
whatever is was set to.

This way, you can quickly set the clip to random playback during an espe
music, and then release the button to go back to whatever direction it wa

Next/Previous/Random

It get a bit crazier by using the Select Next Item, Select Previous Item a
selecting these, you can cycle through every item in that group of contro

This way, you can for instance cycle through all the layer Blend Modes. °
the same button until you land on one you like.

Cycling Specific Items

If you really want to get to the nitty gritty of shortcut control, try duplice
assigning it to a different item in a group.

For instance, assigning the same key to both play forwards and play bacl
between these options with one button. Back and forth. Back and forth. B
want to go full control ninja, you can even use Piano in combination with

You can assign as many items to the same key as you like. Resolume wil
item on every key press.

Using CCs

You can also assign MIDI CC shortcuts to a group. This will let you cycle
group. In most cases, this is not so very useful, but it can be fun to cycl
with a rotary.

You can find a special Shortcut Group in front
triggers. It's revealed when you enter MIDI sho
When you assign a shortcut to it, you can trigg
in that layer with a single control. Assigning a
you trigger clip 1 through 128 by sending differ
that same CC.

TipThis works on columns too.

MIDI Specific Modes

When you're assigning shortcuts for use with a MIDI controller, you get a
modes as well. Which modes are available depends on whether you're as:
message or a MIDI Control Change (CC) message.



TipEvery MIDI Message allows you to change its Channel and CC or Note
doing, you can use these to manually change the MIDI message associate
assigning shortcuts for your controller, you don't have to worry about thi

MIDI CC Options

MIDI Control Change sounds very impressive, but it's basically just used
0 and 127 from a fader or rotary knob. When assigning a MIDI CC shortct
Absolute, Button, Relative and Fake Relative.

Absolute

Absolute is pretty straightforward. It just lets you control the range of th
of your fader or rotary knob. This is the mode you'll want to use on most

For instance, using Absolute mode, you can assign a MIDI fader to the O
the fader up makes the layer fully visible. Pushing the fader down makes
actually explaining this to you. I'm nothing if not thorough.

If you want, you can Invert this behaviour, or set a specific Range.
Button

Button is a bit weird.

Some MIDI controllers, like for instance the Korg NanoKontrol series, cal
press a button. This makes very little sense from a logical perspective, ¢k
reasons.

Using Button mode, you can tell Resolume that this CC is actually being
Resolume no longer thinks you're moving a fader, and you get access to
modes like Toggle and Value.

Relative



Some rotary knobs don't send out fixed
between O on their left side and 127 on
right side. Instead of coming to a stop
end, you can twist them endlessly in bc
directions, and they will keep sending
different values. For instance, the APC40 MK1 has a relative rotary abov
MK2 even has two, the second one is placed on the top right next to the

This is very useful for setting parameters with a big range that you need
Position X or Y, adjusting the BPM. You can also do fun things like scrat
these type of knobs.

If your controller has a rotary like this, you'll want to use Relative mode

In Relative mode, you can change the responsiveness of the rotary by ch
Steps the rotary controls, or its Step Size for each turn of the knob. The
on each other, so changing one will update the other. Basically, a higher
Steps, and a bigger change in value when you turn the knob. A lower Ste
and a smaller change in value.

Toggling on Loop will cause the parameter to loop back to the beginning
so you can keep on spinning forever. Also, you can Invert the shortcut.

Fake Relative

Fake Relative is not some shady figure claiming to be your uncle at parti

Some controllers have rotary knobs that you can spin endlessly, but that
rotaries. Instead, they send out regular values between 0 at the far left :
you're supposed to use them like a regular, Absolute rotary.

The first ReAct controller had these type of controls, and interestingly e
series has them on both the MK1 and MK2.

Using Fake Relative, you can trick these rotaries into thinking that they"'!
rotaries, and you can use all the options you have for the regular Relativ

MIDI Note Options

MIDI Notes are messages that turn something On or Off. Their usually se
of your MIDI controller. On some controllers, they can send 'velocity' val
you press the button.

Because MIDI Note are basically the same as your keyboard, you have th
Piano, Range and Value. Between these, you can cover most bases.

Velocity

One special mode is Velocity. If your controllers supports this, you will ¢
you press the button. The harder you press, the higher the velocity will &



In Velocity mode, you can set the Range as well. This way, you can do fu
scale of a clip by pressing a button. The harder you press, the bigger the
maximum of 200%. When you release the button, it will drop back to 1009

MIDI Clock

MIDI Clock is kind of an odd one out in tt
It's not really a shortcut, but more a mea
syncing Resolume with other devices or a
Because it's not a shortcut, you set it in
of the Preferences.

The principle is simple. Let's say you're playing together with a musician
makes sense that you both want to run at the same BPM. So when she st:
follow along automatically.

One way to do this is to use MIDI Clock. Your musician friend can enable
Ableton (it's called Sync there) and send this to you via a MIDI cable, vi
Resolume will then listen to this, and put your sets in syn

The consists of a few commands, most importantly Clock Tic
Clock Stop.

When you first enable Clock Input for a device, Resolume will wait for th
devices send this when you press play.

It will then listen to each Clock Tick. These get sent on every beat by th
Resolume's BPM will follow along, as if you were tapping the beat by han
Automatically.

Via the dropdown, you can decide how Resolume reacts when it receives
'Start/Stop' mode, Resolume will stop the BPM when the master stops. In
it will continue running, even when the master has told it to stop.

TipMIDI Clock was great in 1996. It's notoriously wavy &arc not really ac
gives a much tighter sync, and is way easier to set up.

MIDI Out

Do you like pretty colors on your MIDI controller? Of course you do. So t

A lot of modern MIDI controllers have colored pads. By changing tthhe velc
controller, you change the color of the pad.

TipWe have lookup tables for most controllers, so you can select the col



instead of having to figure out what velocity is which color. On the APC4
swatches!






For a simple Toggle or Value shortcut, you can set which velocity to sent

For Clip Trigger shortcuts, the party really gets started. As it turns out,
whopping 5 states. So you can choose which color to send out for each s

Shortcut Presets

You can save presets for every shortcut mode. This allows you to save a
and shortcut assignment for different occasions.

For instance, if you're a gear head, you can have different presets for ec
normal person could have have different layouts for the same controller,
styles of shows with it. Or you could have a separate preset for that one
musician buddy. The sky is pretty much the limit.

Every shortcut you assign is automatically saved into the current preset.
the dropdown in the Shortcuts panel. Here you can also mbheaqge. \Soamepre
as.../RemodRenameptions at the bottom of the list.

Presets are simply XML files stored on your computer. So you can exchar
computers, or share them with your VJ friends. Or share them with other

forum.

Once selected, you will see a list of all assigned shortcuts for this prese



This list contains each and every shortcut you currently have assigned, ¢
troubleshoot things. If you're a bit of a nerd, you can probably already s
controlling, just by looking at its name.

By default, the list is organised per shortcut name. You can also sort it j
really easy to spot double assigned shortcuts. These will be marked in re



You can delete a unwanted shortcut by hitting backspace or selecting De
menu. Bad shortcut. Bad.

Default

Resolume ships with a few default shortcut layouts that we think are kinc
you're free to modify it how you see fit, or completely ignore it. Resolum

Peep the shortcuts fcr the thea and the . Yo.



DMX Shortcuts

Controlling Resolume with the mouse is great. You can access every parz
precision. But during a live performance, you'll want to have more contro
offer. Sometimes, you want an exact thing to happen at an exact moment
and search for it with the mouse. That's where shortcuts come in.

You use shortcuts to assign a button on your computer keyboard or MIDI
Resolume. Sort of like how CTRL-C and CTRL-V are shortcuts for copy-pe
get to decide what the shortcuts are.

Resolume supports external control via your computer keyboard, MIDI col
messages. If you're running Arena, you can also use DMX input from a li¢

In this chapter, we'll show you how to control Resolume from a lighting d

Setting Up DMX Input

You can assign DMX shortcuts exactly the same way as you do for your k
controller.

The only difference is you'll use Art-Net instead of MIDI, so you'll need f
sending Art-Net to it first. You do this via the DMX tab of the Preference

"But Resolume, my desk doesn't support Art-Net. Can't | just send regula

Well, I'm pretty sure your computer doesn't have a DMX port either, so if
DMX, you're going to need to convert it to digital one way or another. Ins
with USB dongles that all work differenify, find youiself a , and you'll

be golden.

"You know you just said 'analog Digtal MultipleX"', right?"

Ehm. Yes. That's pretty silly.

To be honest, | had no idea what the abbreviation stood for, and | mistak
send it along a cable which needs a terminator to avoid reflections, the =
defense, I'm a video guy and when you say "terminator", | only think of s

to prevent an uprising in the future, thereby causing a time paradox whic
uprising and a series of increasingly disappointing sequels.

The point | was trying to make was that if you're sending DMX with a 5 o
plug that into your computer anyway. You'll always need a box using a pr
something that your computer can understand. We think that Art-Net over
reliable and future proof option. There, happy now?

Tiplf configuring Art-Net is completely new to you, there's some nitty gri
subnet masks and interface adapters below. If you're familiar with config
just read on for the Resolume side of things.



Create a
new DMX
input via
the New
Input
button in
the
bottom.

Subnet / Universe

This will create your first Lumiverse. You can assign which Subnet/Unive
listening for Art-Net. It will default to Subnet/Universe 0:0, which is the
you know which Subnet/Universe your desk is sending on, you can set Re
Otherwise, you can set up your desk to send Art-Net on the same Subnet

TipAfter creating a new input, Resolume will let all nodes on the network
available. So if your desk supports Artpoll, it should pop right up.

If you need more than 512 channels, you can create another Lumiverse v
another. And another. And another. And another. And another. Holy crap,



many controls for?

"Lumiverse? Excuse me? Don't you know it's called Universe? Oh ma gaa
anything!"

Yes, you're right. Lumiverses exist only inside Resolume, hence the nam
to create virtual inputs and configure your signal flow, before you actual
nodes. And when the node is disconnected, your shortcuts don't disappec
want to switch Subnet/Universe settings during setup, you'll have to do t
Lumiverse, instead of updating 512 different shortcuts. But yeah, video ¢

Channel Offset

If you need to offset your first channel because you programmed other fi
universe, you can do that using the Channel Offset.

Assigning DMX Shortcuts

Let's start with a simple shortcut. We want a flash
So when we press that button, the whole output sho
This is useful as a sort of panic button ("oh no, get
screen!"), or to create tension before a big drop.

You create shortcuts by opening the Shortcuts menu, and choosing which
create a shortcut for. The interface will now change color. For DMX shor:
pastelly yellow.

Basic Shortcuts

Everything yellow can have a shortcut assigned
the Composition Bypass button in the top left of
and click on it with the mouse.

Now you can either use DMX Learn and press the flash button on your de
Press the button and voila, you've assigned your first shortcut! If the By
enough, you could even read which shortcut was assignhed to it.

Personally, | prefer assigning channels manually. Right click on the Bypse
"Create DMX Shortcut". Resolume will automatically assign the next avai
button.

Either way, now press the Escape key to exit the Shortcut mode, and you
shortcut to toggle the Composition Bypass on and off. On and off. On ant
Stop. That's enough.
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Shortcut mode, and select the Composition Bypass again. In the bottom r
see the Shortcuts tab. This tab is only visible while you're in Shortcuts r
all your shortcuts in a handy list.

You can also choose different options for your selected control.

The only option you have for DMX is to invert the incoming value. Everyt
on your desk.

Of course, you can also change the channel manually. If you're using mo
can also change which Lumiverse this shortcut belongs in.

Shortcut Target

When you assign shortcuts to clip triggers or controls on the layer, clip «
this target option. The Target option lets Resolume know exactly how yol
shortcut. There are three modes:

By Position

This target just applies the shortcut to whatever orde
layers are in. This is the default mode for shortcuts «
group panels.



For instance, shortcuts for Layer Opacity default to By Position. Because
your first fader to control the first layer in your composition, regardless
layers afterwards.

This Clip, Layer or Group

This target applies the shortcut to this specific clip,
regardless of where you move it.

This way, you can assign a shortcut to always trigger a specific clip, like
matter whether that clip is in layer 1, column 1 or layer 27, column 95. I1
that specific shortcut.

Bewara¥hen you delete that specific clip, layer or group, of course the st
it!
Selected Clip, Layer or Group

This target applies the shortcut to whatever clip, layc¢
currently selected. This will always be the clip, layer
currently shown in its respective panel. This is the d
any shortcuts you apply on the clip panel.

Wait? What?

"Come on, Resolume! Why you gotta make this so difficult? | just want to
it. Ain't nobody got time for this! Just tell me what to do already!"

If you're unsure about what any of this means, just go with the 'By Positi
shortcuts. It makes the most sense when working with a fixed controller |

The 'Selected' target is very powerful to optimise controller real estate,
what you're doing.

The 'This' target is usually only necessary to control a very specific thin
only.

Shortcut Groups

Shortcuts Groups are shortcuts applied to a group of Radio Buttons, or t
what Radio Buttons and Dropdowns are exactly? They're explained in det



Shortcuts assigned to these type of control are special. A regular contro
options, On or Off. Shortcut Groups have a lot more.

The Clip Direction controls have four options, Forward, Backward, Pause
Autopilot has four also. The Layer Blend Modes have so many options | |

When assigning a DMX channel to a Shortcut Group, Resolume will distril
group. So if the group has four options, like Clip Direction, value 1-63 w
backward, 64-128 will be forward, 128-191 will be pause and 191-255 wil

Clip Trigger

You can find a special Shortcut Group in front of !
It's revealed when you enter DMX shortcut mode.

assign a shortcut to it, you can trigger all the clif
with a single control. Assigning a DMX channel wi
clip 1 through 255 by sending different values on

channel.

TipMThis works on columns too.

Shortcut Presets

You can save presets for every shortcut mode. This allows you to save a
and shortcut assignment for different occasions.

For instance, if you're a gear head, you can have different presets for ec
normal person could have have different layouts for the same controller,
styles of shows with it. Or you could have a separate preset for that one
musician buddy. The sky is pretty much the limit.

Every shortcut you assign is automatically saved into the current preset.
the dropdown in the Shortcuts panel. Here you can also mbeaqge. N\Soawmepre
as.../RemodRenameptions at the bottom of the list.



Presets are simply XML files stored on your computer. So you can exchar
computers, or share them with your VJ friends. Or share them with other
forum.

Once selected, you will see a list of all assignhed shortcuts for this prese

This list contains each and every shortcut you currently have assigned, ¢
troubleshoot things. If you're a bit of a nerd, you can probably already s
controlling, just by looking at its name.



By default, the list is organised per shortcut name. You can also sort it j
really easy to spot double assigned shortcuts. These will be marked in re

You can delete a unwanted shortcut by hitting backspace or selecting De
menu. Bad shortcut. Bad.

Where's the Auto-Map Preset?

"Resolume! What happened to the Auto-Map? | can't find it anywhere!"

We took it out. Half of the stuff that was in the Auto-Map was pretty muc
control over Anchor Y? At 8 bit resolution?

Because a Resolume composition is highly configurable, you can't really
Map. You already missed out on good stuff like effects and BPM synced ¢
miss out on even more good stuff like groups and envelopes.

"So you're telling me | have to make my own personality now? That's cra.:
consuming."

It's really not. If you were using the old Auto-Map, chances you were onl
control their intensity and maybe change playback direction or the transi
controls didn't make much sense anyway. Recreating that's going to take
both in Resolume and on your desk. After saving that as your own preset
forever.

Better yet, you can now create your own show file with unigue controls, v
operator in the process.

Interestingly enough, for VJ's, it's common practice to set up your own p
your own controller layout. In fact, it's a bit frowned upon if you don't kr
own controller.

If you're really stuck with this, there is a user created DMX preset that r
Map in



Nitty Gritty Network Setup

Before you can use Art-Net in Resolume you first need to make sure your
correctly in Windows or Mac OX. You need to make sure the device (or st
to Resolume is in the same |IP range as the computer running Resolume.

So which IP do you need? Of course this depends on your other devices.
IP ranges suggested by the Art-Net spec, and most lighting consoles will
range. The Subnet Mask should also match and usually is set to 255.0.0.

Your IP address can be configured in

OSX System Preferences > Network. Choose the connection you want to u
options, choose to Configure IPv4 > Manually

PCControl Panel > Network and Internet > Network and Sharing Center >
Settings. Double click the connection you want to use and scroll down to
(TCP/IPv4) and set Use the Following IP Address.



Network Adapter

Art-Net gets sent over your network. Just like the internet. So to make s
correct connection, instead of the WIFI (gasp!), you can choose which ad

You do this in the DMX Preferences. The Network Adapter dropdown show
adapters. Keep in mind, this selection affects both DMX in- and output.



This is also very useful when using two wired networks, one for Art-Net &
NDI or OSC. Or another abbreviation.

A word on using Localhost

This works in most cases on Windows. It works in some cases on OSX. B
same port for sending and receiving, officially, this shouldn't work at all
option, so you can at least try.

But yeah. Officially, it's very bad practice to let two applications on the
same port. In most cases, using the right "order of operations"” will get vy
then the receiver.

Keep in mind that as far as your computer is concerned, this really is un
your mileage may vary.

Counting Universes

In DMX, a universe is 512 channels of data. If you need to send more tha
those in a second universe. Art-Net can send a lot of universes over the
those is kind of interesting though.

Every Art-Net universe is defined by a Subnet number, and a Universe nu
Subnet number and Universe number together, you form the Art-Net unive
word 'Universe' is used twice with slightly different meanings.

The 16 Subnets each have 16 Universes, which together form the 256 poc
IlI. The first 16 universes can be found as Universe 0-15 on Subnet 0, the
found as Universe 0-15 on Subnet 1, etc.

TipArt-Net universe = Subnet * 16 + Universe + 1
So the first Universe is Sub:Uni 0:0, the second Universe is Sub:Uni 0:1.

Confused? You should be. It gets even worse! Every developer uses a dif
and naming universes.



For instance MadMapper doesn't use Subnets at all but counts Universes
from 0. When setting up Art-Net, GrandMa does use Subnets and counts ¢
Subnet from 0 to 15, also starting at 0. But internally, it doesn't and cou
Wtf.

In Resolume, although we think starting at 0 with counting is ridiculous,

Art-Net spec and go with the Subnet/Universes designation, starting at O

Node Name

The node name helps you identify each Resolume instance in the Art-Net
set to "Arena" followed by your computer's name.

You may change it to Donkey or Monkey.

Troubleshooting

Arena has a built-in Art-Net monitor. If you're familiar with the Artnetom]
interface.

You access the monitor by folding it open with the arrow in the top right

You will then see a list of 16 Subnets with 16 Universes each. This list w
the currently selected adapter. Subnets with activity will show up in dark
that Subnet to see the active Universes on that Subnet. These will also s
turn, you can select the Universe to see the data per channel. If you wan
you can then see the history for each channel.

So in this example screenshot, we know that there is activity on Subnet (



Subnet 0, we see that there is data being sent on Universe 0, 2 and 4. B
could see which Universes are being sent on that Subnet.

If there is no activity at all anywhere, there is something going wrong wi
the source of the Art-Net.

If there is activity here, but Resolume is not responding, something is gc
that case, you'll want to make sure your Lumiverses are set to the correc
that you've configured your shortcuts correctly.

Credits

Art-Net is designed by and Copyright Artistic Licence Holdings Ltd. Bla b



OSC

OSC offers you the ultimate control over every aspect of Resolume.
OSC stands for Open Sound Control. You can read more about

The important things to know is that you can send OSC over a network, a
control than via MIDI or DMX. You enable OSC in Resolume in the OSC t:

OSC Addresses

Every item in the Resolume can be controlled via its OSC address. Instec
mouse, you control things by sending messages to a control's address. It
sending an email to Resolume, telling it to set a certain control to a cert

The addresses are all fixed and set up already. This means that with OS(
everything right away. Unlike MIDI and keyboard shortcuts, that require \
a specific shortcut.

For instance, if you would like to set the opacity of layer 1 to 25%, you s
address "/composition/layers/1l/video/opacity", while specifying 0.25 as a

/Ilcomposition/layers/1l/video/opacity 0.25

That's it! That's all you need to do. There's no need to assign any shortc
always use this OSC message to set the opacity of layer one. On every c
All the time.

You can control every Ul item the same way.

Let's say we want to set the playhead of clip 8 in layer 2 to the beginnin



by sending the following message:
/flcomposition/layers/2/clips/8/transport/position 0.0

So how do you figure out what the address is for a particular control? Al
logic to it, it's easiest to just enter OSC Shortcut mode (Shortcuts > Edit
control.

The Shortcuts panel will show you the correct address. You can click the
copypasta goodness.

"But Resolume, why don't you have a list of every OSC address in Resolu

Yeah, kind of, but not really when you think about it. The list of address
how you have your composition set up. Also, it adds up quickly. Like, res
idea, here's a list with the OSC addresses for a composition with only on
without any effecis.

Multiple Addresses

Some controls can be accessed by more than one address. For instance,
addresses by which you can access the Speed parameter of a Goo effect

Which one you need depends on how you want to use it.

The first one is what wbsodllhellleess. It controls the Goo effect in the firs
first layer only.

The second oneresatheeldress. It always controls the Goo effect, but on a
depending on which layer is currently selected. So if you have Goo effec
control each of them with the same OSC address. You just need to switct

If there is no Goo effect on the currently selected layer, it's still perfect
to this address. It just won't do anything.

Type Tags and Range



When you select a Ul item, you can also see its Type Tag. Type Tag is a
you can send to an address and what the result will be.

Float

For instance, /composition/video/effects/transform/scale has the type tag
1000.0).

This means that you can send fractional values between 0 and 1, to set t
to a value between 0% and 1000%. So sending 0 will set it to 0%, sendin
500% and 1.0 to 1000%.

Similarly, /composition/video/effects/transform/rotationz has the Type Ta
-180.0 - 180.0). This means that the values range from rotated 180 degre
degrees clockwise. Sending 0.5 will put it smack dab in the center.

Int

Some address have Int as a type tag.

For instance, the layer one blend mode can be reached at
fcomposition/layers/l/video/mixer/blendmode. And you can send it a whol
and 50.

Each whole number will select one of the 51 available blend modes.
"Wait. 51? But you said whole numbers to 50?"

Yes. Us computer types like to start counting at 0, so that gives 51 in to
do, but humour us, please.

Nerd Aletflyou're so inclined, you can still send a float value to address
result in a linear translation of the the float value between 0.0 and 1.0 t
you're addressing.



Color

As a special case, you can send an OSC color value to

OSC color values have the type tag r followed by an unsigned integer rer
color. You can write a color as arn int by . If that all sounds very ner
you can check out Vezer, which does all the hard work for you.

String
You can send text to text inputs. This way you can dynamically update th
Animator sources.

Strings have the type tag s followed by the text itself.

Absolute values

"Hold up, Resolume. This whole type tag thing sounds needlessly comple
and looking up which blend mode is what number. And who in their right
writes a color by shifting bits? This is super geeky! Can't | just say what

Good point, and yes, you can. Well, you're a VJ, so by definition you're 1
yeah, you can just say what you need. Just not like a normal person.

For instance, for blend modes, you can just send the name of the blend n
string.

/lcomposition/selectedlayer/video/mixer/blendmode "Alpha"
This will set the blend mode of the selected layer to alpha.

If the application that you use to send OSC will let you send multiple arg
similar thing for absolute values.

This makes a lot of sense if you want to position a clip on a specific x al
this by first specifying that you want to use the absolute value. You do t
argument after the address, followed by the absolute value itself.

/lcomposition/layers/1l/clips/l/video/effects/transform/positionx "a" 320
This will set clip 1 in layer 1 to 320 pixels along the x-axis.

Relative values

It gets even better! You can specify relative changes to a value.

For instance, you can use a "+", "-", or "*" to respectively add, subtract

with the incoming one:

/lcomposition/layers/1l/video/opacity "+" 0.2
Will increase the opacity of layer one by 20%.

Well, actuallllly... It adds a fixed 20% to the opacity value. It doesn't ac



would be /composition/layers/l/video/opacity "*" 1.2. But | didn't know h
sentence that humans can also understand.

Sending OSC to Resolume

Okay, so by now you probably understood the concept of how OSC works
you actually send OSC?

Good question! There are a looooot of applications that can send OSC.

A few of the more famous ones &amrd , that are both available for iOS a
Android devices. Both TouchOSC and Lemur let you create your own cust
them an ideal pairing with Resolume's fixed addresses. It means anyone
you've created, and it will work out of the box.

On OSX, there is the amaYienzer is wicked because it lets you create comy
animation, which can then in turn be used to control every item of Resoll

And Resolume power uskalAgdsaoreaied which adds functionality
make Resolume more suited for theater show control.

OSC really shines when used in combination with a creative programming
you create your own logic or extract data from various processes, and pi|

Processing, openFrameworks, Arduino, TouchDesigner, JUCE, Max/MSP a
libraries to support sending and receiving OSC messages. You can use M
Ableton Live. There's even javascript libraries to send OSC right from th

The options are pretty much endless. To get you started, here are two ex
use OSC in and

Making Connections

OSC messages get sent over a network. If you want to use OSC between
have to make sure they are connected to the same network. OSC messag:¢
you're not sending 1000s of messages per second, a WIFI network can be

TipThe strength of a WIFI network goes down considerably when 5000 pe
a party.



If you want to send OSC from one computer to another, the sender first n

send its messages. When you enable OSC input in Resolume, it will let o
where they can send their messages. It does this via a protocol called Ze
Bonjour on a Mac. |If your sender application has support for this, Resol

destination.
If your sender application doesn't support ZeroConf/Bonjour, you will nee

and port number manually.

IP addresses are basically a string of numbers that let computers know w
other. Resolume will let you know the IP address of the computer it's run
OSC Preferences.

Every application can specify the port number on which it would like to ri
By default, in Resolume this is port number 7000. You can change it to w

The OSC Preferences tab has a fold out window to see the last 200 OSC
has received. This is a great way to check if you are actually receiving a
messages actually are.



OSC Output

Aside from listening to OSC messages,
enabled via the Preferences as well.

Resolume can also talk back via ¢

There's a few ways that you can manage what messages Resolume sends
Shortcut presets.

Go into OSC Shortcut mode via Shortcuts > Edit OSC. The Shortcuts pan
check your current OSC output setup, and switch between a few presets.

By selecting the "Output AlIl OSC Messages" preset, Resolume will output

Doh-doi.
This means that everything that changes in the interface will be sent out



midi input, parameter automation, clip playhead position. For everything.
Absolute and relative.

This is great, because this way, you can monitor the current state of Res
could be designing an application that takes a particular action based on
Output All preset, you can quite easily filter the incoming data for the ac
in and base your logic on that.

It also means that things can add up quickly. When sending messages ov
connection, it's quite possible you lose a few messages here and there.

To make sure you get the data you need and just the data you need, you
preset. You do this by selecting New... from the Preset dropdown. After ¢
"Leia". Because she's the princess of presets), you can selectively go th
you'd like to send OSC output for.

Let's say you're only interested in knowing whether the master bypass is
let your control application know that it's safe to make certain changes w
bypassed.

To do this, find the Master Bypass button in the t
clicking, you can enable OSC output for this and
Alternatively, you can also enable OSC output for
OSC Shortcuts panel.

By selectively enabling output for just the items you're interested in, yol
network traffic.

Wildcards

But hold up, Resolume. I'm interested in the opacity of each of my 12 lay
clips in my deck. I'm not going to sit there and click each of these items.
my life. Like binge watching every season of Rick and Morty.

Yeah, | feel you. That szechuan sauce is important. That's why we introd
layers and groups, you can enable OSC outputs for all items at the same

Let's say we're interested in the video opacity of every
creating an OSC Output Shortcut for just one layer, we
scope to 'All Layers'.

Boom. In one fell swoop, we've enabled output for the video opacity of al
the same thing for clip triggers, even clips that haven't been added vyet.

Custom OSC Messages

Sometimes you're not interested in the state of Resolume's interface. So
send a little message to another application. Maybe you want to trigger &



trigger a certain clip in Resolume. Maybe you want to link the playhead c
physics in a Processing sketch.

| don't know if these are good examples or not. You're supposed to be th
to do anything cool with OSC anymore because I'm stuck in an office writ

This is possible via a Custom Address.
After creating OSC Output for something you can select this via the drop

Resolume will fill out the current address for you, but you can change it
Resolume will then send the value the item has in the Resolume interface
instead of the fixed one.

Destinations

Just like other applications need to specifically send OSC to Resolume, |
needs to have a destination as well.

In the OSC Preferences, you can select all
applications on your network that announce
via ZeroConf/Bonjour.

You can also choose to send to jusltothabhogetrpudeall computers on your ne
(Broadcast

If you want to send to an application that doesn't support ZeroConf/Bonj¢
Address manually.

In the case of Localhost, Broadcast and manual IP, you also need to set
should of course be the input port of the other application.



To Bundle or not to Bundle

Toggling Use Bundles packs all your messages together and sends them
OSC applications don't really care whether you send bundles or not, but
on or off.

Polling

You can also ask Resolume what a certain parameter is set to. This is gr
control mechanisms, that have different views depending on what's going

Instead of constantly monitoring what's coming out of Resolume, you can
need, when you need it.

You do this by sending a "?" to the address that you want to know about.
For instance, when sending
/lcomposition/layers/l/video/mixer/blendmode "?"

to Resolume, you'll get a reply on the same address with the int value of
layer 1. Pretty awesome.



Sync with a DJ

Yes, you can use Resolume to sync visuals to your tracks. It's what a lot

The process takes a lot of preparation though. You can't play random sor
video content, and get a fully synced show. If only it were so easy.

First, you need to have videos for every track that you want to play in yo
to match exactly to the music. For instance, you could have a video wher
exactly the same time as they're sung in the music.

Once you have all these videos prepared, you can use several ways to sy
is to use Denon players and mixers and use Resolumelfsyou don't have
access to Denon gear, vyou camstead.



SMPTE

SMPTE Input is available on Resolume Arena only!

Resolume Arena can sync the playhead of a video to external SMPTE timi
used technique to synchronize audio, video, lights, pyro and lasers durin
intros. Also it's used a lot by VJs touring with a DJ to sync pre-made vis
Resolume Arena can listen to two SMPTE inputs simultaneously, so you c¢
mix.

SMPTE is just an audio signal that sounds like 400 pigs screaming. Reso
sound and use it as a clock. Every part of it sounds slightly different. O
Resolume can. So when you skip ahead in the SMPTE signal, or play it fa
knows to update the playhead accordingly.

To connect a SMPTE signal to your computer, all you need is a source of
your computer hear it. Playing an mp3 file with SMPTE on your iPod, con
line-in of your computer already is good enough.

Playing it over speakers and using the laptops onboard mic won't work. LC
very stubborn and enjoy failure.

Setup

When your computer is connected to a valid SMPTE input, you can let cli
the incoming SMPTE signal and required framerate for each input via the
Preferences. The Composition tab will now show the current SMPTE time

Framerate

Which SMPTE framerate is correct depends on the source of your SMPTE
this will be 25 or 29.97, but it can vary. If you see a jump in the playhea



second, you most likely have the wrong framerate selected.

Note that the framerate you have to match is the framerate of the incomi
clip you are trying to sync to it. Of course, you get the smoothest result
matched.

You can select your clips to run on SMPTE 1 or SMPTE 2 via the Timelin
will appear in the layer strip to indicate that this clip is now listening fo
switch inputs with the buttons in the bottom right.

Note that SMPTE is not available on clips with an audio track.
Offset

You can select a starting timecode for a clip via the offset parameter.

The offset is helpful to differentiate between tracks. When doing several
single night, an often used convention is to let each show start at an off
start at 01:00:00:00, Show 2 at 02:00:00:00. This way, you won't acciden
at the wrong time.

Note that the clip has to be active in a layer for it show in the output! Tt
sent via SMPTE.

Delay

Optionally you can add an delay compensation in frames to account for a
the signal flow. Light travels fastexnthhanyshignsdfregas®und will take longer
the video to reach the majorityAohdpatcvevwad.mpensation can help with get
perfectly lip sync again.

Test file

For testing, tere’'s



What SMPTE isn't

SMPTE is not a magical tool that will let you sync up randdmuvinsillafsrso r
need to have a finished video for a finished audio track for SMPTE to be

It is purely a technigue to make the playhead of a video clip run exactly
an audio track.

It is very rare, even for top name DJs, to have a completely synced SMP"
relies on his or her own timing and skills to run the majority of the show.
very important show moments that are very difficult to time, or need to b

Syncing with a DJ
SMPTE can also be used to sync video to a track played by a DJ.
The hard part is actually sending the SMPTE.

There are automated solutions for this. and all provide a
similar service and are used by the visual teams running the shows for A
Hardwell, among others.

If you want to get DIY, the easiest way is to split the track. Put your mus
the SMPTE on the right channel. The music goes to the speakers on the |
goes to Resolume on the right.

Of course, this means you can only send a single mono channel to the sp



Sync to Denon DJ Players

Available on Resolume Arena only!

When using a Denon mixer with Denon players, you can automatically syn
DJ to a video in Resolume. Resolume will keep an eye on what track is Ic
sees a linked track, it will sync the video for you. This way, your show w



Technical setup

The first
thing to
make
sure is
that your
players
and
Resolum
e are on
the same
network.

On the stage, make sure that you're connected to the "PC" connection on
In front of house, make sure your computer running Resolume is in the s:
mask as the players. The easiest way to do this, is to use a router that h
let the router do the rest.

When connected, start up Resolume. You will see the available players o
players can be connected and synced to at the same time.

Resolume will let you know when it can't find any players at all. At this ¢
your network setup and firewall status. Resolume will let you know what
the firewall, but maybe it's wisest to just completely open the firewall al;

run a fully sync AV set, you shouldn't be using the laptop to browse the
content anyway. But hey, no judging.

Tip! If you don't see any Denon related things at all on the toolbar, make
enabled via the View menu.

Toolbar

The toolbar will show important and not so important info about the playe



Fader OpaGihpws the state of the fader on the mixer currently assign
Player Numblerto four Denon DJ players can be connected and syncec
Play/Pause/Stlomws the state of the track currently loaded on the play
Time RemainrHogr much time is left till the end of the track

ArtworkKou liek dah perdy picturez?

Track Name / ArtistShamwwhich track is currently loaded on the player

Linking a clip

To link a video clip to a track on a player, simply drag the player from th

Resolume will now sync the playhead of the video to the audio. It will als
the track is loaded in the player. All you need to do is sit back and relax

Resolume will perfectly follow the time of the audio track. You can do wh
Denon players, and Resolume will follow along. Scratch, loop or slice, ey

TipTo achieve perfect sync and full audiovisual immersion, of course you
audio and video are the same length. You can't just use throw any audio
magic to happen. Because you're lining up perfectly synced AV material,
video to the length of the audio. So should your video file end before the
will eject it.

To identify tracks, Resolume will use the ID3 title that the track has on t
that the track has no proper ID3 title, it will default to the filename itsel

TipDon't have the Denon players handy when prepping your
can also set a clip to Denon playback manually. Simply switc
Denon and fill out the track name manually.

Just like SMPTE playback, Denon playback is only available on clips with



Options

Once a track is linked, you get access to several options.

o0 < O

Here you can limit syncing of a particular clip to a particular player. Thi:
that a certain video clip will only sync when played on Player 1. By keep
doesn't matter which player is playing the track.

Fader

Judge me by my size, do you? For such a small toggle, this holds some v

This will link or unlink the video layer in Resolume to the fader on the m
that loaded the track. When it's enabled, your video won't be visible unti
audible. This will work when using the crossfader on the X1800 too.

You can of course unlink this to keep the reigns in your own hands.
Offset

This will let you make adjustments for any offsets between the start poin
point of the video. We're only human, so we all make mistakes, especiall
time. So if your video accidentally is missing a few frames at the beginni
make sure it still lines up perfectly.

Player Layer Target

It can be difficult to predict on which player a DJ will play a track. And c
double, triple or even quadruple up on each clip to make sure you're real
don't accidentally eject the playing video. This is what the Player Layer



You set the target by right clicking on the pl
toolbar. Here you can choose which Resolum
video should go, depending on which player
track. So if the DJ starts a track on player 2
target is set to layer 8, the video will play ir
DJ had started the track on player 1 while th
target is layer 7, it would go in layer 7.

For this feature to work, you do need to set the Clip Target for all the cl
The quickest way to do this, is to select all the clips and change their CI
Determined via the right click context menu.

Tipllf you are running a fully synced composition, you can also set the CI
level. This way, newly added content will be set correctly on import.

Time for another baconaitor layer, player.

Supported Models

Mixers
e X1800
Players

e SC5000
e SC5000M



BPM

BPM is how we indicate the tempo of modern dance music. It stands for E
of 120 means you have a beat every 0.5 second. Every musical genre has
around 100, EDM is typically around 130, trance can go up to 140, while
hardstyle and drumnbass like it at 160 and upwards.

Beats, Bars and Phrases

If this concept of BPM is really foreign to you, put on your favourite dant
where the beat kicks in. Now you'll hear this distinct pattern that the kic
dum-dum-dum-dum-dum-dum. You're probably nodding your head along to

Every 'dum' that you hear is what we call a beat. Depending how fast the
more or less of these in a minute. Hence the name BPM or Beats Per Min

Now in dance music, every 4 beats make up a 'bar'. In turn, every 8 bars
more in-depth explanation of these concepts, check out the video below.

Okay, with that theory out of the way, let's get back to Resolume! Resolvu
your content to the BPM that the DJ is currently playing. These BPM coni
VJd'ing, you can find them on the toolbar in the center of the interface.

Setting the BPM

There's a few ways you can set the BPM.

On the off-chance that you know exactly what BPM the DJ is playing at, \
by clicking the BPM value and typing it in.

Now let's say you don't know the DJ's tracklist by heart. In that case, by
BPM is to just use your ears and tap along to the music. You do this by c
few times to set the tempo. Tap the button in time with the beat. 1-2-3-4
this for a few beats, click the "Resync' button on the first beat of the neyv
'Resync', everything in Resolume that is set to BPM Sync will jump back
bar of the first phrase.

Now keep your eye on the blue square moving clockwise around the sligh
your BPM is on right on point, it should hit the top left corner on every f
even better indication, this square will light up with a little outline every
if you're still in sync with the phrasing.

When you find the blue square is arriving a little late, it means your BPWM



difference won't matter too much, but you'll get further and further out o
on. You can fix it by increasing the BPM slightly by hitting the 'plus' but
you can hit the 'minus' when it's arriving early, or just tap out a new tem
off.

Now hit "Resync' again on the first beat of the phrase, and see if it drifts
right. This is how DJs beat match records as well, and after a little pract
on the correct BPM very quickly.

If you don't like the hard cut you get from pressing 'Resync', you can als
'Nudge Down' buttons. These will temporarily speed the tempo up or dowi
button pressed, and set it back to where it was when you let go. This wil
music, or let the music catch up to you.

If you're playing a video only set, you can also send out a metronome to
can beat-match your visuals using audio.

Later on we will see how we can aor.e to synchronise the tempo in
Resolume with another program or piece of equipment.

Rhythm in Visuals

"But wait," | hear you yell, "what does all this rhythm stuff have to do wi
DJ!"

Well, you're right. You don't necessarily have to beat-match all your visu
playing tunnel fly-throughs that don't really have a visible rhythm, you're
controls. But if there's anything obviously rhythmical in your video, it m
match with what happens in the music. And one obvious way of doing tha

For instance, imagine you're playing a short walk-cycle animation of a bi
If you hate dubstep and Mecha, that's cool. Just bear with me for a secol
of them annoying kids that need to get off your lawn.

Of course, it makes sense that every step of the Mecha coincides with a
play the video like that, it will look as if the video was made for that tra
is such a powerful tool.

So first of all, make sure that every 'event' in your video happens in mul
robot take 4 steps, 8 steps, 16 steps, 32 steps etc. This way, Resolume
for you when switching the clip playback to BPM Sync. Then all you need
sync, and all your videos will follow along.

The video linked here is actually a bad example. The robot takes 12 step
its alcohol problem, but really bad for syncing. When you download that
play back in 12 beats, or trim it so it only takes 8 steps. Or better yet, d
Youtube at all and learn to make your own awesome Mecha robot content
of steps.

Of course, this doesn't just work for big Mecha's and dubstep. It also wo



machines pulsing and blowing steam on dark techno tracks, or strange al
telepathic pulses from their third eye on goa trance music. It even works
on big room EDM. Rhythm is life, and life is rhythm.



Dashboard

The Dashboard is a great way to control Resolume.

The Dashboard can be found at the top of the Clip, Layer, Group and Cor

Control at a Glance

It's purpose is much the same as the dashboard in your car. When driving
everything about how the engine is doing. But it is a good idea to keep t
going, how many rpms the engine is turning, and maybe how how hot it's

The same goes for Resolume. You don't need to know every setting of ev
and forget. But you do want to keep track of the important ones, the one:
them on the Dashboard, you have instant access to them and their values
down into the effect stack every time.

For instance the opacity of an Automask effect. The R, G and B values of
the Distance parameter of an RGB Shift. The choice is yours.

To add a parameter to the Dashboard, simply drag it to the dial you need
nerdy and take more time than necessary, you cah also select Dashboard
down, and then select the dial you want.

The dial will rename itself to the name of the parameter. Of course, you
you want by double clicking the name.

TipYou can add multiple parameters to the same dashboard dial. Great fo
complex looks using a single dial.

Options

Once a parameter has been added to a Dashboard, you get access to a fe
Parameter In and Out point

Of course you can set the in and out point for the param. This will let yo
dial to only affect a small part of the parameter.

This is great for very sensitive controls, like the Global parameter on Tw



combining multiple parameters together.

Invert

Make the parameter move up when moving the dial down and vice versa.

Dial Range
This is an interesting one. You use it to set which range of the dial contl

the inverse of the parameter in and out point.

For instance, by setting the out point of the Dial Range to 0.33, the first
full range of the parameter. You can then use the remaining 2/3rds to co|
from the same dial. When combined with the Invert option and the parame¢
point, this gets really freaky.

Remove

To remove a parameter from a dial, right click the parameter.



Envelopes

Envelopes are most awesome!

Envelopes allow you to adjust the exact flow of your parameters. Instead
Resolume can adjust your parameter to have a nice ease in and ease out
even multiple keyframes!

Using Envelopes

To enable an envelope, simply right click a parameter and select Envelor
get some direct visual feedback, let's go with a Slide effect and apply th
parameter. But you can use any other parameter you want instead. Resol

At this point, Resolume will apply the envelope to the input of your parart
input! So it will modify a parameter set to Timeline or BPM Sync, but als
parameters controlled via MIDI or OSC.

By default, a linear envelope is applied. This means you don't see any re
linear themselves.

Easing

Let's change that by applying some easing.

Right click on the second keyframe of the envelope, and choose Quadrati



down.

When you now click and drag the X parameter, you will see the quadratic
While dragging the parameter from left to right, the actual X position of
in the beginning, then pick up speed halfway through, and slow down aga

Such smooth. Much ease. Very wow.

The actual value of the parameter is represented by a smaller vertical lir
bigger vertical line. You can think of the big one as the input, and the sr
after the envelope is applied.

Of course, you can set the paremeter io . The envelope will be
continuously applied and you get a nicely eased curve.

Interpolation Curves

Interpolation is a fancy word for how the line between t
look. You can choose from a variety of interpolation cur



Quadrati®ingCircularndExponentichd basic easing at vario sl ssti@agidasn.d
Bouncéet you do some of the harder to moste without breaking a swe:
Holdsimply holds the value of the previous keyframe until the current one

Curves are always applied between the keyframe you've selectecd wrve the
will apply the curve at the start of the® untanryelatildnapihhy it towards the e
In/Outwill apply it equally on both sides.

Adjusting Keyframes
To adjust a keyframe, simply click and drag it around.

This will update the value the parameter is outputting in realtime.

Adding and Removing Keyframes

To add a keyframe, double click the curve where you want to add it. Of c
both vertically and horizontally.
To remove a keyframe, double click it.

Saving Envelopes

Envelopes are saved as part of the preset of the effect you're applying ti
possible to re-use a preset on a different effect.



Preparing Media

While Resolume is designhed to get you up and running quickly, if you are
visual performance then you should really take some steps to get the mo!
and your content.

Installation

The nature of audio-visual performance is that it needs as much processi
especially if you want to mix lots of layers, apply loads of audio and videé
high resolution.

While software like internet firewalls, virus checkers, desktop utilities ar
day to day use, they do consume computer resources and you do not nee
performance.

For maximum stability and performance, the best thing to do is to have m
of Windows or OSX on your computer, with one set up with the bare minir
You can then boot into your stripped down, high performance OS when yo
Resolume.

If you don't want to create a separate installation for performance, the n
user account that is set up to run less software at startup. This is not as
separate installation, but it will help.

To manage users in Windows, open Control Panel from the Start menu, al
Accounts. Make sure that the User account you create also has Administr

To manage users in Mac OSX you open the Accounts settings in the Syst

Codecs

Do not install codec packs like the K-Lite Codec Pack. They install a lot
can cause more harm than good. Only install the codecs that you actually

The next section has loads of advice on what codec to use.

Preparing Media

Choosing how to encode your content is critical in audio-visual performa
choosing a 'codec'. Thi@hpmdssfE Gmpressor. Your choice of codec dete
how much processor time is used to decompress each video frame. This i
many layers of smoothly playing video you can use and how many effects

Use DXV!

For the very best performance in Resolume you should uselthies by far the
fastest codec because Resolume can decompress the video frames on the



Separate Audio and Video!

We highly recommend rendering the audio and video in separate files anc
a clip in Avenue instead of rendering a video file that also contains audi

Keeping the audio and video in separate files is better for your work-flow
audio of a clip and not the video you only have to re-save the audio file
entire video file with the audio again.

The audio and video is often created using different software, sometimes
By combining the audio and video files in Avenue you can create the mus
software and create the video in your video app of choice.

There is another problem with including audio in video files - it limits the
When rendering a video file with audio, the length of the file is quantize
of the video. This makes it impossible for audio to loop seamlessly at ce

For example, using PAL video format at 25 frames per second, it is not p
AV loop at 90BPM that will loop perfectly. The closest we can get is a 66
actually be at around 90.9 BPM

Avenue transposes the video to the length of the audio in a clip to create
visual clip.

Audio Compression

Don't compress audio. Period. Don't do it.

Save it to an uncompressed (linear PCM) .wav file. Avenue needs very fa
leaving it uncompressed enables this. Uncompressed audio files are relar
uncompressed video files so reducing the file size with compression is ni

In most cases using a sample rate of 44,100 kHz and a bit depth of 16 bi



Input Maps

A LED processor usually takes a single video input (DVI/HDMI/VGA/comp
signal over the connected LED walls.

Single LED screen

In the case of a single LED screen, setup is relatively simple. The proce
the video signal and shows it on the LED wall. Let's say your LED wall is
output your processor expects would look something like this:

The processor will only take the top left part from a regular video signal
video signal is 1024x768, but it could be any standard video resolution. |
384x192 pixels in the top left of that signal. The rest it throws away.

You could of course render all your content to this scale before show, bu
the Advanced Output.

Output Map

Create a new setup, and on the Output Transformation stage, you make y
pixels in size and place it exactly in the top left of your output.



Input Map

Now switch over to the Input Selection stage, right click the Slice, and h
will place your slice exactly in the same place as it has on the Output Tr
back to the center, letting the snapping do the hard work for you. Now sc
entire Input Selection stage again, Make sure you hold down both Shift a

proportionally from the center!



What you have now is a slice that takes a 2x1 piece of your composition
of your output. This means that you will exactly see that part on your LE
output shape, you've made sure your input slice has the same aspect rati
This means you probably lose a bit of the top and bottom of your compos
still look like circles and not squished eggs.

4 screen LED wall

Now imagine your stage is a bit more complex and looks like this:



The annoying thing is that the 4 screens are positioned like that on the s
processor. In the LED processor, they might be arranged something like 1
done to minimize the data sent along the cable connecting the LED scree

We've included a Photoshop mockup in the bottom right to help you get tl
processor relates to the stage.



TipKeep in mind that 4 screens like this are still controlled by a single L
send out one signal from your computer's output. The processor divides i
very complex, high resolution LED stages will you need to use 2 or more
outputs.

Output Map

Just like with the single LED screen, first you recreate these slices in th
of Resolume's Advanced Output. This way you send the processor the sig
you're working with a LED supplier who knows what they're doing, they c:
mapping' before show. All you need to do is fill out the numbers that the:
slices to keep things organized.



Input Map

Then, on the input, lasso all four slices to select all of them. Then right
Output Shape. This will pop the 4 slices into the exact same position anc
output stage.

Place the 'Center' slice exactly in the center of your comp. Place the oth
are on the actual stage. Unless you want to break out the tape measure,
guesstimating and eyeballing. In the end it's about selling the illusion to
matter if you're a few pixels off.

TipDepending on the stage, there's always a certain trade-off between c«
When you're dealing with a few low pixel pitch LEDs combined with a lot
perspective correct input map could require your comp to run at 4K or ab
a good idea to sacrifice a bit of correctness for the sake of still having ¢

Once you're satisfied with the layout, lasso all the slices and scale ever
again. Shift and Alt are your friends here!



Placing Content

Now whatever you play in your composition will translate perfectly to you

DJ's name to only appear on the center wall, all you need is scale it dow
till it fits.
Or even better, you can t-e the to place content directly in every sl

want.






Tipllf you're working with LED walls with mixed pixel pitch, you can scale
the Input Selection stage. This will keep their output resolution the same
pixels as input. This way, the overall image on the stage will still look p¢

Projection Mapping

As far as the output is concerned, projection mapping is usually a lot mo
eyeballing than working with LED screens. Even then, having a good inpu
saver.

Let's take the following example of a structure consisting of 8 cubes.

Even though you might not know the exact alignment of the objects on th
it's going to be positioned like this.



You can already start working on this before you even arrive at the venu

To have some creative options on this stage design, you might want to pl
entire structure, and other content only in a single cube or in a combinat

We'll use an input map to make this a piece of cake.
Input Map

First thing is to create an input map based on this shape. We start by cr
shape, in the Advanced Output using slices.

First we have to figure out how big to make our composition. If we take a
(1920x1080 pixels) as our starting point, we will need 8 slices of 360x36
because the object is 3 cubes high and 1080 / 3 = 360.

This means that our Resolume composition will be 1080x1080, because c
So set the composition size to 1080x1080.

Open the Advanced Output and make sure you are working on the Input S

Let me repeat this, because | don't think you heard me. Make sure you al
Selection stage. We're not interested in the Output Transformation at thi
which parts of our composition to use.

After you've created the first slice, place it exactly in the bottom center
Now create copies and place them around the stage, in the same position



will go really quickly, because you can alt-drag to copy the slice, and th
original and the composition edges.

Bam. Your input map is done.

Composition
Fullscreen

Now in the composition, we'll make our first layer our Fullscreen layer. T
input map already takes the correct input from the comp. We'll lose some
content on the sides, but we're keeping the aspect ratio intact so our cir

Moving right along.



Duplicated

Layer 2 will be our Everywhere layer. We'll put 8 copies of our content,

From the Slices tab (View > Show Slices), drag Screen 1 onto Layer 2. B

We'll duplicate this layer, and use the Bypass buttons for each slice to ¢
create as many duplicate layers as you want content on specific cubes.



Specials

On the last layer we'll add some animated Lines from the Sources tab. U:
its Pixelation parameter at almost maximum, we'll have 9 blocks of white
can use this as a mask or as some stroby bump content.

Aligning the output

When you're at the venue and connected to the projector, go to the Outp
lasso all the slices and right click them. Choose Match Input Shape and



place they have on the input stage.

Now move and scale the cube grid roughly into position. Where necessar!
corner points to align exactly with projection. After a little work, the prc
line up exactly with the actual object.

Custom content

Because you have created an accurate input map, you can easily mix cus
regular VJ content. As long as you make the cubes in your content exactl
exactly 1080x1080, it will line up perfectly with your other content.

VJFit has an for this setup.

An added advantage is that, should you do this show in a different locati
same animations and input map. All you need is adjust the output to the
and you're good to go for show!

Non-geometric objects

When working with objects that are not geometric, you have to rely on th
input map. For instance, to map on an inflatable skull like this, you will
content in Cinema 4D based on the measurements of the actual skull.



Then you divide the skull into several poly slices, one for each major pal
with a slice for the forehead, one for each eye, jaws, nose, left cheek an
lower teeth and chin. Of course, you can create more or less poly slices,
you want to be. You can go as far as creating a poly slice for each tooth



Then you position and scale each poly slice roughly in the projection anc
perfectly.

Tip!lOn any projection mapping job, take plenty of breaks, bring a thermoc¢
A masseuse is optional.



Edge Blending

Edge Blending is only available on Resolume Arena!

Edge blending is the dark art of stitching together the output of two or m
and making one seamless screen out of them.

Resolume will help you do this by gradually fading out the area where thi

Overlap the Input

In order for edge blending to take effect, you need to have your slices p:
of your composition. This overlap should mimic the physical overlap of th
surface. In other words, you need to make sure that the slices overlap th

physical projectors do in the real physical world.

Tip!For best results, a minimum of 15% overlap is recommended.



You can use the test card ( Output > Show Test Card ) for this. Display vy
projector and keep moving the slices towards each other until the image
the same pixels in the overlapping area. The test card has numerical valil
the correct spot on the grid.



Align the Output

On the output side, you need to make sure your projectors are aligned pr
this is to perspective warp each output while projecting the testcard agal
corner points one by one until the grid aligns perfectly.

TiplPerspective warping are the four big corner points of your slice. Make
their smaller baby brothers that only do linear warping.

Blending

Then you can turn on edge blending for each slice in turn. Resolume will
edge in the middle. Magic!



Finetuning

You can still control the edge by refining the following three parameters:

Gamma Red, Green anlhBslwe:ntrols the overall brightness of the red, gret
channel of the softedge overlap area.

PowerThis control the slope of the edge blend curve. The higher this num
curve will be in the center of the fade area.

Luminancéhis control the brightness of the centerpoint of your fade. This
adjust the slope of the curve.

Gammarlhis is the overall brightness of the fade area.



Black Level and Brightness Compensation

Since projectors project light, they can never p|
black (black actually is the absence of light). R
project a very deep grey. So where two projecto
this causes the problem to double up. In the are
be 'blacked out' by softedging, they will project
deep grey.

The result in the overlapping area will be an even lighter grey. The black
make up for this difference, by allowing you to make the non-overlapping

TipBlack Level Compensation is available on the output tab.



Slice Routing

Layer to slice routing is a very powerful tool. It
create complex setups very easily. It also has si
drawbacks, so use it with caution.

Routing Layers to Slices
Every individual layer of a Resolume composition is also available as an

By default, slices take the complete Resolume composition as input. You
used for a slice on the Input Source dropdown on the right hand side of t

After you have selected a layer as a direct input, you can warp and trans
completely separate from the composition.

This is for instance very useful when you want to display different conte
case, you can use layer to slice routing to keep your composition size doc
comp size at 1920x1080, and play each layer in its own slice. This way y
huge video containing your 6 videos in one. This is very efficient and do
on your computer and graphic card.

Ignore Opacity and Bypass/Solo

You can choose to bypass both the the layer's oy
Solo and Bypass toggles.

This is useful if you want to see the layer only in this slice. Simply toggl
switch, and then bypass the layer in the composition. The layer will no Ic
but it will stay visible in your slice.



Routing Groups to Slices
On Arena you can also create groups.

Just like layers, groups can also be routed to a slice. You will have the
Opacity and Bypass/Solo.

Routing the Preview to Slices

This is useful to get the Preview output in a separate external display.

Routing Screens to Slices

This is some serious slice-ception over here.
You can route the output of a Virtual Screen to a slice in another screen

This way, you can add more phases to the warping process. For instance
physical outputs using the regular blending process. Then, you can let e:
slices take its input from a virtual screen. In this virtual screen you can
content to physical objects, without having to worry about the overall ble

There's a few other useful scenarios, most of them get too complex to ex
in a manual that no one reads.

When NOT to use slice routing
"When you have a hammer, not everything is a nail."

Keep in mind that by routing a layer to a slice, you actively decide to by,
completely. When a layer is routed to a slice, all layer and clip effects w
modes and composition effects will not! The slice will simply render all c
on top of the other slices.

Layer to slice routing can let you make setups very quickly, but you can
yourself into a corner. It's best used to display layers of content on sepe¢
sure you never want to mix them.

Don't use it as a quick way to position content!

Let me repeat that, because | don't thih&nytts eh etdA\rsd anguicKlT wayo.sition
contentYou will not be a happy camper.

If that's what you want to do, use theffect instead. We have a whole cha
this manual dedicated on how you can c¢rdateaaciomplex stage design.



Media Manager

Clip Reconnect

If you have moved your source files around on your computer accidentall
instance when switching laptops, or reorganizing), Resolume will indicate

Clicking on the Relocate button will open the Media Manager. The Media
all the files used in your composition, and mark the missing ones in red

TipThe Media Manager will need to save your composition before it can d
about the current state of your comp, you might want to save under a dif1
the Media Manager.



The quickest way to find missing files is to press 'Locate All..." in the bo
This will open a file browser, where you can select the folder containing

Are you missing files spread over more than one folder? No worries. Just
to a higher folder that contains all the folders containing your files. It w|
subfolder until it's located all the missing items.

The Media Manager will automatically save your composition every time i

Relocate Single Files

If you prefer, you can also click the 'Rel
next to a specific. This will let you brow:
specific file.

After you've relocated that file, Resolume will do a quick search in the s
missing files, and fix those as well.

Replace File

You can use the Media Manager to replace a partic
different one.



Right click on the file you'd like to replace and choose Set Path. You car
like to replace it with. This is a great way to update a particulalrhfide witf
time it's really the final version. | promise there will be no more changes
Def v2.mov"

Collect Media

The Media Manager can also be used to collect and gather the files in yo
place.
To do this, select 'Collect Media' from the bottom left.

The Media Manager will show you how many files there currently are in vy
much space they take up. You can then select a folder where you would |

TipThe Media Manager always copies! Resolume will never try to delete |
holy.

At this point, you have two options.

Copy Composition

This will copy all your files into a single folder. It will then make a copy
place it next to the files, and update the file location.

This is great for moving a showfile with all its content to a separate driv

Update Current Composition

This will also copy all your files into a single folder. It will then update -
with the new locations.

This is great for cleaning up the mess that you made when you were bein



from 23 different subfolders on your computer, 12 more subfolders share!
laptop, 6 subfolders on 2 external drives, 1 file from that Hello Kitty thul
under your pillow, 2 files from your Google Drive and one picture from yc

By updating the current composition, Resolume will copy all these files i
point the composition to their new locations. So much more tidy.



Recording

The record function records the composition output to disk and immediate
into Resolume as a new clip when you stop recording. All this is done wif
output.

Before you start recording, you need to go to the General tab of the Pref
the folder that you would like recorded files to be stored in and whether
video, audio or both.

By default the files are stored in Documents/Resolume Avenue 6/Recorde
To start recording press the '"Record' button on the toolbar. To stop reco

That was pretty simple huh? The movie you just recorded is saved to disl
empty clip on the bottom layer so you can directly use it again in your m

Note that recording does not interrupt your mixing or the video output so
on the effects and layers while you are recording.

The recorded video files are Quicktime with the Photo Jpeg codec at 100
are in uncompressed WAV format.

Note that the record function is not intended as a full fledged video prod
meant to quickly record and then play back a content that has a few effeq
so that for instance you do not have to continuously keep moving a fader

If recording suddenly stops, this is because you have run out of memory.
Resolume tries to write the rendered frame immediately. This is done at .
because you don't want this to interfere with the actual output. So when
effects/clips/pixels), it stores the rendered frame in memory, and tries tc
point, when the memory is 90% full, it will stop recording and write the r
memory.

If you want to record longer segments, you will either have to write to a
resolution.



Ableton Link

Ableton Link is an open source protocol that helps musicians keep in tim
sync the tempo of different devices or software.

It's design is very much like an open jam session. Once it's running, eve
session and control it. It works over network, so anyone connected to the
able to join in.

Using Link

By default, Link is hidden in the View menu. After making it visible via V
button will pop up in the toolbar. You can then click the button to turn Li

At this point, Resolume will start looking for any other software in a Link
will join automatically. It will show you how many other devices are curre

It will now automatically keep the BPM and the current position in the me
connected computers. Change the BPM in Ableton and Resolume will follc
forward a bit in Resolume, and Ableton will follow.

When using Link, the Resync and Pause buttons for the BPM are disabled
musical practice to do a hard reset of the measure like this, or completel
altogether.

Great power, great responsiblity

Link assumes complete equality of everyone in the session. This means vy
just as abruptly as anybody else. So when you hit x2 on the BPM to acce
BPM on all other connected softwares will speed up as well.

This is great if you're just using Link to keep multiple VJ computers in s



not be so amused by it.



Preferences

General Preferences

Record

Here, you can set the directory that Resolume will use to store recording
whether to record Video and/or Audio. Se2 ihe ferctdi®etaida on how this wo

Clip Panel

Choose whether or not Resolume should update the clip panel when a cli
to turn it off when you are for instance using an external source for trigg
(via MIDI, OSC or DMX for instance), while you are applying effects on a

Clip Start Offset

The Clip Start Offset allows you to let a clip start an amount millisecond
the clip, to compensate for delays with MIDI triggering and/or long cable



Scrolling

When this is checked, Resolume scrolls the deck to the clip or layer you
if you need to see that particular part of the deck. Can also be annoying
another part of the deck. It's a matter of preference, really. Hence this t

Font

The Arial Unicode checkbox changes the font used by Resolume. If you a
characters, and having trouble displaying them correctly please enable tl

Quit Confirmation

When Quit Confirmation in enabled, Resolume will wait for you to confirm
decided to quit. With this disabled, Resolume will shut down immediately
CTRL/CMD+Q or choose to quit via the menu.

Tip!Turn off the Quit Confirmation in combination with the 'Trigger First
Loaded' function found in the Layer menu to use Resolume for fixed inste
starts up and shuts down automatically.

Audio Preferences

The audio tab presents you with
options that control how audio ¢
be output from Resolume.



Audio Output Device

Under Audio Output Device you can select the device that Resolume shou
an ASIO device is selected, an extra button will be displayed that enable

Output Channels

You can then select which channels should be used for the main output v
Channels. If you are using an audio device that supports more than two c
the channels used for monitoring the preview audio via Preview Output C

Sample Rate

Higher sample rates provide higher quality audio but will require more pr
audio effects are in use. 44100 is a good choice.

Buffer Size

Higher buffer sizes will introduce more latency into the system but settin
may cause glitches in the audio. 512 or 1024 are usually safe choices.

Audio Input Device

Similar to selecting the output device, here you can select which device
incoming audio.

Audio FFT

Under External Audo FFT Input you can the channels that shoutd vbe used
You can boost the gain if the signal is coming too low.

TipYou can also set the FFT gain in the main interface via View > Show F

SMPTE

On Arena, you can select which channels to use for your source of SMPT
about this in the

VST Directories

VST Plugin Directories are the directories (folders) that Resolume shoulc
effects and sources.

Video Preferences



FFGL Directories

On the Video tab, you can select the directories that you want Resolume
and sources.

Resolume always checks the Extra Effects folder in the user's Documents
setup, install custom plugins there. They will then load automatically on

Preview Monitor Background

You can set the preview monitor background to display transparent pixels
a light checkerboard, or just as black.

MIDI Preferences



MIDI Devices

Here you can enable or disable MIDI input and output from and to device
for all about input, clock and output.

Middle C

This will let you decide which note is used to display the Middle C.

Behind the scenes, MIDI doesn't actually use musical notes, just number:
number 60. To make this more confusing, every application has a differer
note this actually represents.

Ableton Live uses C3, Traktor uses C4.

This doesn't actually change anything in your MIDI shortcuts. It just char
displayed in Resolume. It makes sense that when you're working with sev
you're using the same notation.

OSC Preferences



Here you can enable or disable
input and output, as well as set
relevant ports and IP addresses
by OSC.

For more info check the section on

DMX Preferences

The DMX preferences tab is available on Arena only.
You can read all about setting up Lumiverses and Art-Nai nodes ir the

Keep in mind! The Network Adapter switches both Art-Net input and outpt
adapter!

Defaults



This section allows you to chan
several default settings to be u:
when importing files or creating
composition.

Default Transport and Play Mode

Whatever you choose here, will be the default setting for files that you il
on.

So for instance, if you always use your video clips on BPM Sync and 'pla
choose these as the default settings.

You can choose different settings for video and audio. AV files or videos
will use the settings for audio.

Note that this does not affect clips that were already imported. Also you
for individual clips after importing as well.

Default Blend Mode
Choose which Blend Mode newly created layers will use.
Tempo Nudge Range

When nudging the BPM up or down, this sets what percentage of the curr
up or down with.

10% is good when doing actual audio stuff. Personally | think 25% is mor
visuals to music.



Yeah, | know this is not actually a default setting. It should go in the Ge
was full. You want to do something about it? Come at me, bro.

Feedback

Here you
can contact
us to tell us
how much
we suck.

Or how
awesome
we're
doing. Or a
bit of both.

Either way, we always love to hear from you.

Registration



Read all about making your Resolume legit and how to switch your licens
the



Rendering to DXV

The Resolume DXV Video Codec is a hardware (GPU) accelerated codec.
video frames is done directly on the video card.

Today's video car@msohmwals processing power available. They®XK¥anodec m
work on much higher resolutions and frame-rates, with much lower CPU a

Rendering

Rendering movies with the DXV Codec is extremely easy because there is
key-frames, nothing. It is pre-configured to be as fast as possible. All yc
DXV 3 Codec, choose your preferred preset and start rendering.

For a detailed guide on how to export with most major video applications

Playback of video files with the DXV codec is only hardware accelerated
When a DXV video is played with any other software (like the Quicktime [
the videocard so there is no performance gain in other software but Reso



Normal Quality vs High Quality

We advise to do all encoding at Normal Quality. Only if you notice a lot ¢
should you use the High Quality setting.

Expect file size to double when encoding to DXV3 HQ! With great power ¢
so don't use High Quality as your default render setting. You'll run out o
use it on files that have visible artefacts when you render them to Norma

There is no need to re-encode your entire DXV2 library. Especially do no
to DXV3 High Quality. Because you are rendering from a DXV2 source, ar
already rendered into the file. Your image quality will not be improved at
get is bigger files that look exactly the same. And that's not what you wa

No Alpha vs With Alpha

The DXV codec can also store the alpha channel. Just choose any of the
render with included alpha channels.

Keep in mind that your original file needs to have an alpha channel for tl
Choosing one of these options will not magically create a transparent ba
does not contain it.

When your source does not have alpha channels, it's best to use the 'No
size down.

Exporting .mov files with DXV encoding

Resolume Alley

The easiest way to create DXV encoded files is to use Alley. This is by f
option. It's so simple the files almost encode themselves, but you can re
in

Adobe After Effects, Premiere and Media Encoder

Resolume comes with plugins to export directly to DXV3 from the Adobe |

These plugins get installed automatically when you install Resolume and
Effects, Media Encoder or Premiere installed on the same computer.

If you like, you can download thdoAilheyaildsttted | ptugins separately as well.



you can export to DXV on a computer that does not have Resolume, or wk
any of the Adobe applications.

When you do not have any of the Adobe apps, the plugins are not installe
stays clean.

Once installed, this is how it works in each application:

Adobe After Effects

e Choose Composition > Add to Render Queue

e Click the Output Module settings (by default this is set to 'Lossless")

e Choose the following options:

o Format > DXV 3

oln the Format Options, choose whether you want Normal or High ¢
without alpha. The channels and color depth will adjust themselv



Adobe Premiere Pro/Adobe Media Encoder

e From Premiere, choose File > Export > Media

e In Media Encoder, click on the preset name

(From here on, both apps use the same interface).

e Choose the following settings:



o Format > DXV3

o In the Video tab, select the resolution, pixel aspect ratio and fra
to use.

o Under Compression, choose whether you want Normal or High Qu:
without alpha.

Quicktime Player 7 Pro

Quicktime 7 is still supported on OSX and works great.
e Choose File > Export
e Under Export, choose 'Movie to Quicktime Movie'
e Click Options
e Click 'Settings' in the 'Video' tab
e Choose the following settings:

o Compression Type > DXV 3



e Choose the desired compression setting from the Compression dropdc¢

Mpeg Streamclip
Don't use MPEG Streamclip.
Compressor

e Drag a preset to your source content, we recommend starting with 'Q
with Alpha’

In the Video tab, click Change... next to Quicktime Settings.

Now choose the same settings as for Quicktime Pro above:
o Compression Type: DXV 3

o Compression: Choose the DXV 3 preset for the quality and alpha

Make sure your Pixel aspect ratio is set to 'Square'

If that sounds like a lot of work, Lere's a for each of the four DX



render settings. The presets should be unzipped and copied to ~/Library/
Support/Compressor/Settings/



Tech Specs

Minimum Specs

Windows

e Windows 7 SP 1 or later, 64 bit
e AMD or Nvidia graphics card with 256MB of VRAM
e 4GB RAM

Mac

e OSX 10.9 Mavericks or later
e AMD, Nvidia or Iris Pro graphics card with 256MB of VRAM
e 4GB RAM

Recommended Specs

Windows

e Windows 10

i7 Processor, Quad Core, 3.8 GHz
Nvidia GTX 1080

M2 SSD

16 GB Ram

Mac

e OSX 10.13 High Sierra

e i7 Processor, Quad Core, 2.8 GHz
e Radeon Pro 555

e SSD

e 16 GB Ram



Modifiers and Shortcuts

On both the Input Selection and Output Transformation stages, there are
modifiers and contextual menus to help you move and reshape your slice:

General Shorcuts

e Ctrl-Znc€trl-YCmd-Z and Cmd-Y on a Mac) undo and redo your last ste

Key Modifiers

e Hold dowBhifwhile dragging to constrain movement to either the x or vy
e Hold dowhtwhile dragging to make a duplicate.

e Hold downriwhile dragging to temporarily disable snapping.

e Hold dowBhifwhile scaling slices to constrain aspect ratio.

e Hold dowhtwhile scaling to scale from the center, rather than the opp
e Hold dowhifwhile rotating to constrain rotation to 45 degree angles.

Navigating the Stage

e Ctrl-an€trl-t(cCmd-+ and Cmd-- on a Mac) zoom in and out.
e Mouse scroll wheel zooms in and out.
e Hold dowpacebavrhile dragging to pan around the stage.

Nudging

e Use the keyboard arrow keys to nudge 1 pixel at a time .
e Hold doBhifwhile nudging to nudge 10 pixels at a time.

Slice Shortcuts

e Duplicate @tth-PCmd-D on a Mac).

e When first WdlitnBratgp make a transform@trle®@piyl, then duplicate and rep
the transformation.

e Backspadeletes the selected slice(s).



Mask and Polygon points

Double cliazkkywhere on the path to add a point there.
Double climkpoint to delete.
Shift-cliakpoint to add/remove it from the selection.

Contextual Menus

These differ per item, but generally will let you quickly access frequently
positions.

Center Xenters the slice on the x-axis.

Center ¢cfenters the slice on the y-axis.

Mirror Klaces the slice exactly on the opposite side of the center x-a
Mirror flaces the slice exactly on the opposite side of the center y-a
Left haRfight haBbttom hallbp hasfcale the slice to exactly that half.
Whole Arsaales the slice to the whole stage. This is handy reset opti
messed things up beyond repair.

Make Trianglteates a triangle shape that fills the entire stage.

Make Ciradeeates a circle shape that fills the entire stage.

Bring Forwards/Backmawes the slice up or down in the slice stack. TFt
the same as dragging the slice around in the slice list on the left sid
Duplicatkuplicates.

Match Input / Output Shape

These are so important and useful, we've singled them out for you. They
position and shape that it has on the other stage. This way you can quicl
positioning on the Input Selection stage to the Output Transformation ste

Input/OQutput Guides
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a still image file in the background, to use a guide while lining up your s
It will load the file at its native resolution and position it in the top left
You can adjust the opacity of the input map via the Opacity slider.

Loaded the wrong map to the wrong screen? Replace it via drag and drop
remove it with the 'X' button.

View Options

Show Slice Grid



This will show the outlines and a grid for the selected slice.
Show 8x8 LED Grid

This will divide the output up into 8x8 pixel lines. When snapping is enal
snap to this grid. This is useful for making LED pixelmaps, since 99% of
blocks of 8 pixels.

Identify Slices

This will light up your slices in white when you mouse-over them. In com
Output, this is a great way to make sure your input map lines up with yot
qguickly make sure which slice you need to adjust.

Show in Output



With this enabled, the Image Guides will show in the
This is very useful to double check if everything is a

Also, when Slice Grid is enabled, it will show both the grid as well as a 1
output, to help you get your bearings.



Fixture Editor

When your specific type of fixture does not appea
can create one yourself. You do this by clicking tl
to the Fixture selection drop down.

This will open the Fixture Editor. You can create a new fixture, adjust an
an existing fixture and go from there.

Creating a New Fixture

Let's start by creating our own personality from scratch by hitting the plt
creates a default 1 RGB pixel fixture called New Fixture.

The first thing you'll want to do is change the name to something that ma
manufacturer name and the amount of pixels are usually a good conventit

Note that if you update an existing fixture, and this fixture is already bei
Selection stage, you will update all instances of the existing fixture as w
changes without affecting the current setup, make a duplicate of the fixtt

Setting up Parameters

Then you can set up the parame
you're dealing with a basic LED
tile, you can just assign the am
pixels you need vertically and
horizontally. On the right you w
preview of how your fixture is
arranged.

So a 16 pixel LED strip would have a width of 16 and a heigh of 1. A squ



would have a width of 8 and a height of also 8.
Dummy channels

Depending on the type of fixture, it could be that certain channels are re
of that light. For instance it could be that the first channel switches bety
presets. You see this often in off-the-shelf LED tiles. Your light will havc
manual.

In these cases, you can create extra parameters by clicking on the + icol
Parameters tab. You can re-arrange their order by dragging them up or d
handle on the right of the parameter, similar to how you drag effects up .
effects tab.

This way your light will get the correct pixel data at the correct channels
the Start Channel.

TipSending nothing is not a concept that exists in DMX. When you assign
expects you to always send a value on that channel. So Resolume will se
So if you are adding a Dimmer channel to a fixture, you'll want to set the

For ease of use, you can of course rename these parameters as well.

Channel Distribution

Now is also a good time to adjust your distribu
necessary. Your distribution refers to how your
through your fixture. Some fixtures start at the
then keep going left to right, like you would re:
book.

Other fixtures start top left and zigzag back and forth on their way down.
pretty much every variation of this, which are all covered with the 16 dis
you change your distribution, you Il also see the channel layout change i

Color Space



Then you can choose the colour space Yy«
use with your fixture.

Full colour LEDs create colour using separate values for red, green and |
strip, either separate red, green and blue LEDs or a single full colour LE
Selecting RGB (or one of its variations) assigns 3 channels for each LED

Mono coloured LEDs use the weighted luminance value of the sampled pi:
this luminance value over a single channel for each LED in your strip.

Some lights prefer to work with CMY values instead of RGB. Here Resolu
conversion from the pixel's RGB values to the CMY color space.

Resolume also supports less common varieties such as RGBW and RGBW,
color on the extra white and /or amber LEDs by dimming the other channe
this channel instead.

Gamma Correction

If you're dealing with an unusual type of LED, you can tweak the Gamma
Most of the time the default setting of 2.5 should be fine.



Directory List

Resolume creates and stores data in several locations on your computer.

When you are messing around with Resolume's preference files and the I]
you're smart enough to replace the part of the directory name that says "

Application folder

Contains the application and licensing information. Has subfolders for

e Default: contains fixtures, presets for the GUI, sources and effects,
shortcut presets for keyboard and midi.

e Docs: contains language files for GUI and help

e Licenses: contains licensing info for external libs

e Manual: contains the manual. Duh.

e Media: contains the included video files.

e Plugins: contains the included audio and video plugins.

On Mac, it can be found in Macintosh HD/Applications/Resolume Avenue

On Windows, it lives in C:\Program Files\Resolume Avenue 6\

User Documents

This contains all the files that you have created.

e Compositions: all the Resolume comps you've created

e Extra Effects: 3rd party plugins can be installed here and will be loa

e Fixture Library: any custom fixture profiles are stored here

e Preferences: these files store how you've layed out your interface, w
were using, what composition you were using last, etc.

e Presets: user presets for sources, effects, GUI and the advanced out

e Recorded: all the videos and still you've recorded

e Shortcuts: all the shortcuts for MIDI, keyboard, OSC and DMX you've

Can each be found in their own subfolder at

e MAC: Macintosh HD/Users/[username]/Documents/Resolume Avenue 6

e Windows: C:\Users\[username]\Documents\Resolume Avenue 6\

Log files

Can be found at:

e MAC: /Users/[username]/Library/Logs/Resolume Avenue 6 log.txt

e Windows: C:\Users\[username]\AppDatal\Roaming\Resolume



Alternatively, you can use the Feedback option found in the Preferences,
ticked, to send it to us.

Thumbnail Previews & Text Atlas

e Mac: /Users/[username]/Library/Application Support/Resolume Avenuce

e Windows: C:\Users\[username]\AppData\lLocal\Resolume Avenue 6\

Registration files

e Mac: Macintosh HD/Library/Application Support/Resolume Avenue 6/r

e Windowst\USCernPublRublic Documents\Resolume Avenue 6\registration



